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Important Information

SOME TIBCO SOFTWARE EMBEDS OR BUNDLES OTHER TIBCO SOFTWARE. USE OF SUCH EMBEDDED 
OR BUNDLED TIBCO SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY (OR PROVIDE LIMITED 
ADD-ON FUNCTIONALITY) OF THE LICENSED TIBCO SOFTWARE. THE EMBEDDED OR BUNDLED 
SOFTWARE IS NOT LICENSED TO BE USED OR ACCESSED BY ANY OTHER TIBCO SOFTWARE OR FOR 
ANY OTHER PURPOSE.
USE OF TIBCO SOFTWARE AND THIS DOCUMENT IS SUBJECT TO THE TERMS AND CONDITIONS OF A 
LICENSE AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED SOFTWARE LICENSE 
AGREEMENT, OR, IF THERE IS NO SUCH SEPARATE AGREEMENT, THE CLICKWRAP END USER 
LICENSE AGREEMENT WHICH IS DISPLAYED DURING DOWNLOAD OR INSTALLATION OF THE 
SOFTWARE (AND WHICH IS DUPLICATED IN TIBCO GENERAL INTERFACE INSTALLATION) OR IF 
THERE IS NO SUCH SOFTWARE LICENSE AGREEMENT OR CLICKWRAP END USER LICENSE 
AGREEMENT, THE LICENSE(S) LOCATED IN THE "LICENSE" FILE(S) OF THE SOFTWARE. USE OF THIS 
DOCUMENT IS SUBJECT TO THOSE TERMS AND CONDITIONS, AND YOUR USE HEREOF SHALL 
CONSTITUTE ACCEPTANCE OF AND AN AGREEMENT TO BE BOUND BY THE SAME.
This document contains confidential information that is subject to U.S. and international copyright laws and 
treaties. No part of this document may be reproduced in any form without the written authorization of TIBCO 
Software Inc.
TIB, TIBCO, TIBCO Adapter, Predictive Business, Information Bus, The Power of Now, TIBCO General 
Interface, TIBCO General Interface Framework, TIBCO General Interface Builder, and TIBCO General Interface 
Test Automation Kit are either registered trademarks or trademarks of TIBCO Software Inc. in the United States 
and/or other countries.
EJB, Java EE, J2EE, and all Java-based trademarks and logos are trademarks or registered trademarks of Sun 
Microsystems, Inc. in the U.S. and other countries.
All other product and company names and marks mentioned in this document are the property of their 
respective owners and are mentioned for identification purposes only.
THIS SOFTWARE MAY BE AVAILABLE ON MULTIPLE OPERATING SYSTEMS. HOWEVER, NOT ALL 
OPERATING SYSTEM PLATFORMS FOR A SPECIFIC SOFTWARE VERSION ARE RELEASED AT THE SAME 
TIME. SEE THE README.TXT FILE FOR THE AVAILABILITY OF THIS SOFTWARE VERSION ON A 
SPECIFIC OPERATING SYSTEM PLATFORM.
THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR 
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.
THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS. 
CHANGES ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE CHANGES WILL BE 
INCORPORATED IN NEW EDITIONS OF THIS DOCUMENT. TIBCO SOFTWARE INC. MAY MAKE 
IMPROVEMENTS AND/OR CHANGES IN THE PRODUCT(S) AND/OR THE PROGRAM(S) DESCRIBED IN 
THIS DOCUMENT AT ANY TIME.
THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR 
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE, INCLUDING 
BUT NOT LIMITED TO ANY RELEASE NOTES AND "READ ME" FILES.

Copyright © 1999-2014 TIBCO Software Inc. ALL RIGHTS RESERVED.
TIBCO Software Inc. Confidential Information
3/25/14
 TIBCO Formvine Release Notes



| iii
Contents

Release Notes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  1

New Features. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2
Release 3.9.2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2
Release 3.9.1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2
Release 3.9  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2
Release 3.8  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4
Release 3.7.1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6
Release 3.7.0 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6
Release 3.6.2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7
Release 3.6.1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7
Release 3.6  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7
Release 3.5.1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9
Release 3.5  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9
Release 3.4.1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  14
Release 3.4  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  15
Release 3.3  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  21
Release 3.2  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  22
Release 3.1.1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  32
Release 3.1  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  33

Changes in Functionality . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  40
Release 3.9.1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  40
Release 3.9  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  40
Release 3.8  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  40
Release 3.7.1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  40
Release 3.7.0 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  40
Release 3.6.2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  41
Release 3.6.1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  41
Release 3.6  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  41
Release 3.5.1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  42
Release 3.5  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  42
Release 3.4.1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  42
Release 3.4  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  42
Release 3.3  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  42
Release 3.2  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  42
Release 3.1.1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  43
Release 3.1  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  44

Deprecated Features . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  45
Release 3.9.2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  45
 TIBCO General Interface Release Notes



iv | Contents
Release 3.9.1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
Release 3.9  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
Release 3.8  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
Release 3.7.1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
Release 3.7.0 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
Release 3.6.2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
Release 3.6.1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
Release 3.6  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
Release 3.5.1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
Release 3.5  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
Release 3.4.1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
Release 3.4  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
Release 3.3  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48
Release 3.2  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48
Release 3.1.1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
Release 3.1  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49

Migration and Compatibility . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51

Closed Issues . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52
Asynchronous Modular Platform  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52
Charting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
Data Mapping Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55
Deployment  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60
Documentation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61
Dojo Integration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63
Firefox  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63
Internet Explorer. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67
General Interface Builder . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68
General Interface Framework. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78
GIPP/GITAK . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 87
GUI Components . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 87
Installation and Build  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 107
L10N. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 107
Samples . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 108

Known Issues  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 109
Browser Limitations and the Margin Property  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 109
Browsers - General  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 109
Data Mapping Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 110
Documentation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 110
Dojo Integration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 111
Firefox  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 111
General Interface Builder . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 116
General Interface Framework. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 119
GUI Components . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 119
Safari and Chrome . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 120
TIBCO General Interface Release Notes



| 1
Release Notes

Check the TIBCO Developer Network web site at 
http://www.generalinterface.org for product information that was not available 
at release time. 

Topics

• New Features, page 2

• Changes in Functionality, page 40

• Deprecated Features, page 45

• Migration and Compatibility, page 51

• Closed Issues, page 52

• Known Issues, page 109
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2 |   Release Notes
New Features

This section lists features added since the last major (3.0) release of this product.

Release 3.9.2
New browser support:

• Internet Explorer 10 and 11 support added.

• GI Framework (runtime only) supports Safari 6 on Mac OSX.

• GI Framework (runtime only) supports Firefox 26+latest and Chrome 
31+latest.

Release 3.9.1
This release introduces support for the following

• Internet Explorer 9

• Firefox 4

• Chrome 10 and 11

Release 3.9
This release introduces these new features:

• Redesign of the JavaScript Test Utility as a JavaScript console similar to Safari. 
(GI-421)

• Online prototype library. (GI-683) The General Interface Builder Prototype 
Library allows sharing of components across projects and among users, 
allowing you to do the following:

— Save a copy of any component to your user component library. (GI-685)

— Organize the components that you create in your own user component 
library. (GI-684)

— Upload components to the online prototype library for subsequent 
download and use by other developers.

— Drag and drop components that were previously uploaded by other 
developers into your projects. (GI-728)
TIBCO General Interface Release Notes



New Features | 3
• Support for HTML forms in GI DOM (GI-727). This includes general forms 
enhancements. Forms are now apparent in the GI DOM, similar to the way 
that they appear in the HTML DOM. Additional classes have been added to 
support this, including the following:

— NativeForm - extends Block, renders as <form>

— Hidden - for hidden fields

— FileUpload - for file upload fields

— NativeButton - allows easy submit/reset functionality

This functionality also leverages the previously created classes 
NativeSelect, TextBox, and Label, and the prototypes fieldset and 
legend.

• Exposure of DOM nodes in the active component editor as variables in the 
script evaluator (GI-705)

• Flexible per-instance CDF schema. This feature addresses the issues that arise 
with standard data schema due to the fact that few services expose data as 
CDF unless they are designed specifically for General Interface. (GI-702)

• Model support:

— Support for types that extend Model but not Painted. (GI-701)

— Ability of subclasses of Model to control their own serialization and 
deserialization. (GI-700)

• Support for labels to be associated with input controls by allowing a click on a 
label to move focus to the control, as opposed to loosing focus completely. 
(GI-693)

• Prototypes for HTML elements label, fieldset, legend, h1-6 to help with 
accessible applications by taking advantage of native HTML elements. 
(GI-691)

• Support for a GUI class that uses a native HTML select object to render a select 
or multi-select control. (GI-690)

• Ability to open the General Interface launch page, runtime, and applications 
from different domains. (GI-681)
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Release 3.8
This release introduces these new features:

• Test Recorder. The General Interface Test Recorder is a utility included with 
General Interface Builder that records user interactions with an application as 
a replayable test case. The recordings allow you to generate General Interface 
Performance Profiler (GIPP) or General Interface Test Automation Kit 
(GITAK) test cases simply by interacting with your application instead of 
coding test cases by hand.

By simplifying test case development, the Test Recorder dramatically reduces 
the barriers to creating comprehensive test suites for your General Interface 
applications.

• Jabber Chat. General Interface Builder includes a Jabber client, allowing you 
to participate in chats from within Builder. The client is implemented on top of 
the Dojo XMPP library. It works with Jabber servers that support the Jabber 
HTTP Bind protocol, such as OpenFire.

• Dojo Integration and Dojo Widgets (Dijits). General Interface 3.8 introduces 
first-rate integration between General Interface and the Dojo Toolkit. Builder 
includes prototypes for a variety of Dojo widgets. Dojo widgets operate in the 
same way as other General Interface widgets and can be dragged and 
dropped onto the Builder canvas during application development. You can 
also configure Dojo widgets using the Properties Editor and Events Editor.

• Support for Firefox 3.5, Chrome 2.0, and Safari 4.0.
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API Changes

The following new method is included in Release 3.8:

jsx3.app.Model selectDescendants(strExpr : String, bSingle : 
boolean)

This method selects objects from the DOM using a CSS3-like selection syntax. 
This method considers the DOM tree whose root is this object. The following 
constructs are supported:

• jsx3_gui_ClassName — Matches objects by their exact class. Replace "." 
with "_" in the selector.

• * — Matches any object

• #id — Matches objects whose name equals id

• .class-name — Matches objects for which getClassName() is defined and 
returns a string that contains the token class-name

• :first and :last  — Matches objects that are their parents' first and last 
children

• :nth(n) and nth-child(n)  — Matches objects whose child index is equal 
to n

• :instanceof(ClassName)  — Matches objects that are instances of the class 
or interface ClassName

• [prop="value"] and [prop*="value"]  — Matches objects whose value 
for field prop equals value

• or, with "*", contains value. The quotes around value are optional.

• [getter()="value"] and [getter()*="value"]  — Matches objects 
whose return value for method getter equals value

• AB  — Matches objects that match both A and B

• A B  — Matches descendants of objects matching A that match B

• A > B  — Matches immediate children of objects matching A that match B 
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Release 3.7.1
This release introduces support for the following

• Internet Explorer 8 and Safari 3.2.2. 

• Double-click on matrix column dividers to auto-size column width.

• International locales.

• Firebug console log handler.

• Memory statistics in benchmarking code.

Release 3.7.0
This release introduces these new features:

• Asynchronous Modular Platform (AMP), an Eclipse-inspired plug-in 
architecture for building advanced modular and high-performing enterprise 
AJAX applications.

— Manage component files so they do not burden the overall code base.

— Allow decomposition of applications into constituent parts.

— Make working with asynchronously loaded resources as easy as working 
with synchronously loaded ones. 

— Enforce asynchronous behavior by providing only asynchronous APIs.

— Provide declarative definitions of component publish-subscribe interface.

— Enable extensible General Interface applications based on a modular 
framework.

— Reduce complexity in designing large and scalable applications.

— Generate testable applications with modular framework, generous log 
coverage, and benchmark statistics.

• General Interface Builder IDE based on AMP.

— New modular and fully asynchronous architecture.

— Extensible IDE with build-in extension points.

— Project creation wizard. 

— Re-usable AMP modules.

— Ability to run on browser platforms that do not support native file access.
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• General Interface Builder syntax highlighting script editor.

— XML, XSL and JavaScript resource editor now provides language based 
syntax highlighting.

• Locale format input control.

— Provide subclass of jsx3.gui.TextBox with NumberFormat property 
that formats values and parses input according to the number format. 

• Support for the Google Chrome 1.0 browser.

Release 3.6.2
This release includes fixes to known issues. See Closed Issues on page 52.

Release 3.6.1
This release adds support for Safari 3.1.2+ and Firefox 3.

Release 3.6
This release introduces these new features:

• General Interface Template Language on page 7

• CDF Form Mapping on page 8

• JSON mapping on page 9

General Interface Template Language

Pre-built General Interface components enable quick, easy development of web 
applications. However, developers who need controls that aren’t available in the 
pre-defined component library have faced a development challenge because of 
the complex interactions required by the General Interface run-time engine. 

With Release 3.6, General Interface introduces the template language feature to 
address the difficulty of creating re-usable custom components.

The General Interface template language simplifies the creation of custom GUI 
components by using a technique that is already familiar to web developers—it 
builds on your knowledge of HTML and JavaScript.

Using the General Interface template language, you can convert a single snippet 
of HTML—a widget—into a re-usable component.
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This means that if you’ve developed user interface components that combine 
HTML and JavaScript code, you can convert the functional user interface HTML 
elements into a General Interface template for custom usage.

CDF Form Mapping

TIBCO General Interface 3.6 introduces a new CDF form mapping class, 
jsx3.gui.CDF. This new class enables developers to map a CDF document in the 
local cache to on-screen form fields. 

By combining the features of jsx3.gui.Block and jsx3.xml.Cacheable, this 
new class enables developers to read and write cache data without the need to 
author additional JavaScript code. In other words, this new class is a visual 
container that knows how to bind the form fields it contains to values in a CDF 
document.
TIBCO General Interface Release Notes
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JSON Mapping

The General Interface Mapping utility now supports mapping to JSON-based 
services. Similar to mapping to WSDL and XML, the new JSON mapping feature 
provides a visual tree to which the developer can assign mapping rules. JSONP is 
supported by default, which gets around cross-domain security problems when 
accessing data from other sites.

Release 3.5.1
This release includes fixes to known issues. See Closed Issues on page 52.

Release 3.5 
This release introduces these performance improvements and new features:

• Faster performance in Internet Explorer 6

• New jsx3.gui.Table class and prototype

• New asynchronous loading features

• More useful Vector APIs 

• Support for context-sensitive help in TIBCO General Interface Framework and 
TIBCO General Interface™ Builder

• API Enhancements 

Read these topics to learn more about the new features and enhancements in this 
release:

• Performance Enhancements on page 10

• Deployment on page 11

• GUI Components on page 12

• XML Mapping Utility on page 12

Browse your local workspace 
for a local copy of the JSON file.
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• TIBCO General Interface Builder on page 13

• Documentation and Help onpage 13

• API Changes on page 14

Performance Enhancements

This release includes these performance enhancements:

• Faster overall performance, particularly in Internet Explorer 6

• New properties for asynchronous loading of XML in GUI controls that 
implement Cacheable: xmlAsync, xmlBind, and xslAsync. For more 
information, see TIBCO General Interface API Reference, TIBCO General Interface 
GUI Property Reference, and “Loading Components and XML URLs” in TIBCO 
General Interface Component Guide.

• New loadType property for asynchronous deserializing and painting of GUI 
components. For more information, see “Loading Components and XML Data 
Sources” in TIBCO General Interface Component Guide.

• Options for reducing the size of the General Interface payload by omitting 
messages.xml and locales.xml from system initialization. Use the 
jsx_no_messages and jsx_no_locale deployment parameters to 
configure the runtime of your deployed applications. For more information, 
see “Deployment Parameters” in TIBCO General Interface Developer Guide.

• General Interface Builder displays these statistics for all open components in 
the bottom left of the work area status bar: component file size, component 
object count, time to unmarshal (deserialize), time to paint, and HTML size. 

• A custom General Interface - Professional Edition debug build that can be 
used during development to detect and report such performance issues as 
multiple repaints, multiple box recalculations, times to perform various 
operations, and so on. Visit TIBCO Developer Network at 
http://www.generalinterface.org to download the debug build.

Benchmarking information is reported through the General Interface logging 
system. Run you application in General Interface Builder or deploy your 
application with an active application monitor. These operations are reported: 

— Loading any file with the jsx3.xml.Document class 

— Requesting any resource with the jsx3.net.Request class 

— Loading any JavaScript file asynchronously 

— Loading any JavaScript file synchronously with jsx3.require() 

— Deserializing any component file loaded with Model.load() and its 
variants 
TIBCO General Interface Release Notes
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— Deserializing any asynchronously loaded component file referenced from 
another component file 

— The initial paint of a loaded component file 

— Paints caused by calls to Painted.repaint() 

— Paints caused by calls to Paint.paintChild() 

— Parsing of any dynamic properties file 

— Box recalculations caused by setLeft/Top/Height/Width() 

— XSL transformations in Template.transform() 

Additionally, these warnings are issued: 

— Multiple calls to repaint() on a single General Interface DOM node in a 
single thread 

— Multiple box recalculations on a single General Interface DOM node in a 
single thread 

Deployment

This release includes these deployment enhancements:

• New jsx_browsers deployment parameter that can be used in the script tag 
of the launch page to configure the runtime of your deployed applications to 
override the default parameters for each browser. For more information, see 
“Deployment Parameters” in TIBCO General Interface Developer Guide.

• To prevent General Interface progress bars from overlapping when deploying 
multiple applications in the same page, add position:relative in the 
<div> tag of both deployed applications. For example, 

<div style="width:100%;height:400px;position:relative;">
<script type="text/javascript" src="/3.5/GI/JSX/js/JSX30.js"

jsxapppath="/3.5/GIApps/JSXAPPS/chart/">
</script>
</div>

<div style="width:100%;height:300px;position:relative;">
<script type="text/javascript" src="/3.5/GI/JSX/js/JSX30.js"
jsxapppath="/3.5/GIApps/JSXAPPS/WSDL_Mapping_1/">
</script>
</div>
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GUI Components

This release includes these enhancements to GUI components:

• A new jsx3.gui.Table class and Table prototype - a lightweight table 
component for fast, read-only rendering of large data sets (Component 
Libraries palette > Miscellaneous). For more information, see TIBCO General 
Interface Component Guide.

• Matrix now supports range selection when using the paginated paging model

• A new Multiselect prototype - a Matrix that allows one or more items in a list 
to be selected. To define the list of items, associate it with an XML string, file, 
or cache document (Component Libraries palette > Form Elements)

• Charting

New vector class, jsx3.vector.Block, which extends jsx3.gui.Block 
and defines a base class for GUI controls that implement both the 
cross-platform box profile painting introduced in 3.2 and the cross-platform 
(VML/SVG) vector painting, also introduced in 3.2. See the jsx3.vector 
package in TIBCO General Interface API Reference.

• Support for context-sensitive help in General Interface Framework and 
General Interface Builder. For more information, see “Implementing 
Context-Sensitive Help” in TIBCO General Interface Developer Guide and 
Documentation and Help on page 13 

XML Mapping Utility

The XML Mapping Utility has these new features:

• Ability to clone a mapping rule. Right-click a rule in the Rules Tree panel and 
choose Clone from the context menu.

• Improvements to the XML Mapping Utility XPath

The XPath statement has been improved and now references a 
targetNamespace to identify a Schema, not its ordinal position. This makes the 
Reparse feature for the XML Mapping Utility more useful, because a change 
to the WSDL is less likely to corrupt the bindings.

• The XML Mapping Utility now supports recursive rules, where one rule that 
maps to a CDF record can point to another rule that maps to a CDF record and 
hand off message processing. The jsx3.net.Service.compile() method 
also supports recursion.

Previous versions of the XML Mapping Utility did not support hierarchical, 
recursive structures when creating a rules file. This meant that converting 
deeply nested XML documents that contained repeating structures resulted in 
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very large rules files or rules files that were simply too difficult to create and 
manage. 

To point one rule to another rule, enter the jsxid (Rule ID) of the rule that you 
wish to call in the Path/Value field of the Mapping table in the XML Mapping 
Utility. To find the jsxid (Rule ID), select the rule in the Rules Tree panel and 
click the Rule Node Profile radio button.

TIBCO General Interface Builder

This release includes these enhancements to General Interface Builder:

• Automatic version check in General Interface Builder shows when new 
versions of TIBCO General Interface are available. To manually check for 
updates, choose Help > Check for Updates.

• Links to TIBCO Developer Network and TIBCO General Interface Open 
Source Project (Help menu)

• Download link to TIBCO General Interface Test Automation Kit, which can be 
used to test General Interface applications (Tools menu)

• Additional documentation and help. See Documentation and Help on page 13

Documentation and Help

This release includes these enhancements to documentation and access to help:

• A new Welcome screen in General Interface Builder provides easy access to 
projects and links to TIBCO Developer Network, General Interface Open 
Source Project, and community forums. The Welcome screen loads at General 
Interface Builder startup and is also available from the Help menu.

• Context-sensitive help in General Interface Builder links directly to HTML 
documentation. Move focus to an area of the IDE, such as a dialog, editor, or 
palette, and press Alt+F1 or click the Help button (?), if available. 

For more information, see “TIBCO General Interface Documentation” in 
TIBCO General Interface Developer Guide.

• Compiled documentation for properties, events, and XSL parameters: 

— TIBCO General Interface GUI Property Reference (Help > API 
Documentation > GUI Property Reference)

— TIBCO General Interface GUI Event Reference (Help > API 
Documentation > GUI Event Reference)

— TIBCO General Interface XSL Parameter Reference (Help > API 
Documentation > XSL Parameter Reference)
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API Changes

New APIs in this release include:

• jsx3.app.Cache.ADD

• jsx3.app.Cache.ASYNC_TIMEOUT

• jsx3.app.Cache.CHANGE

• jsx3.app.Cache.getOrOpenAsync

• jsx3.app.Cache.REMOVE

• jsx3.app.Cache.XSDNS

• jsx3.app.Model.getHelpId

• jsx3.app.Model.getLoadType

• jsx3.app.Model.LT_SHOW_DESER

• jsx3.app.Model.LT_SHOW_PAINT

• jsx3.app.Model.LT_SLEEP_DESER

• jsx3.app.Model.LT_SLEEP_PAINT

• jsx3.app.Model.LT_SLEEP_PD

• jsx3.app.Model.onChangeServer

• jsx3.app.Model.setHelpId

• jsx3.app.Model.setLoadType

• jsx3.app.Server.invokeHelp

• jsx3.app.Server.HELP

• jsx2.gui.Table

• jsx3.lang.Class.addMethodMixin

• jsx3.lang.Object.jsxmix

• jsx3.xml.Cacheable.getXmlAsync

• jsx3.xml.Cacheable.getXmlBind

• jsx3.xml.Cacheable.onXmlBinding

• jsx3.xml.Cacheable.setXmlAsync

• jsx3.xml.Cacheable.setXmlBind

For more information, see TIBCO General Interface API Reference.

For deprecated APIs in 3.5, see Deprecated APIs on page 49.

Release 3.4.1
This release includes fixes to known issues. See Closed Issues on page 52.
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Release 3.4
This release includes several performance improvements and many productivity 
enhancements including:

• Faster startup load performance

• Support for one-way WSDL operations

• Multi-selection of components in the Component Hierarchy palette 
(drag-and-drop and multiple property editing)

• Optional workspace path for local HTTP server

• New IFrame component

• GUI component enhancements

• API Enhancements 

• Localization enhancements

Read these topics to learn more about the new features and enhancements in the 
release:

• Performance Enhancements on page 10

• XML Mapping Utility on page 12

• TIBCO General Interface Builder on page 13

• API Changes on page 14

• GUI Components on page 19

• Internationalization and Localization on page 20

• Samples on page 20
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Performance Enhancements

Performance enhancements include:

• The General Interface Load Performance Optimization script, 
util/gi-merge.sh, allows you to create custom builds for your deployed 
applications that are optimized for load performance. See “Optimizing Load 
Performance” in the TIBCO General Interface Developer Guide.

• More efficient loading of the General Interface Framework due to maximized 
asynchronous parallel loading in the system bootstrapper.

• Optimizations to various APIs including deserialization of components, paint, 
and resize of GUI controls.

XML Mapping Utility

The XML Mapping Utility has these new features and improvements in 3.4:

• Support for one-way (request, no response) WSDL operations. 

• The menu command for opening the XML Mapping Utility has changed to 
Tools > XML Mapping Utility.

• Ability to edit the SOAP Use (encoded or literal) and SOAP Encoding 
(http://schemas.xmlsoap.org/soap/encoding/) fields in the Rule Profile 
panel of the XML Mapping Utility. To edit these fields, select an output or 
input rule in the XML Mapping Utility and select the Rule Node Profile radio 
button. Previously, whatever encoding was stated in the WSDL could only be 
changed by hand-editing the CXF. 

TIBCO General Interface Builder

General Interface Builder has these new features and improvements in 3.4:

• Ability to abort loading of the previously open editors when starting General 
Interface Builder. Press the Cancel button in the Opening Project dialog to 
stop loading any open editors.

• The Properties Editor palette now supports typing a dynamic property key 
(ID) in a Value cell, as well as selecting dynamic properties from the context 
menu. Dynamic properties in resource bundle files must be typed in the Value 
cell, because they don’t display on the context menu.

• Multiple components can be selected in the Component Hierarchy palette. 
This new feature provides these enhancements:

— Support for drag-and-drop of multiple selections in the Component 
Hierarchy palette.
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— Allow for drop-in-place adding and rearranging of components in the 
Component Hierarchy palette. Children are added where dropped, not 
below their peers.

— Ability to drag and move groups of absolutely positioned components in 
the work area. 

— Ability to clone multiple components.

— Context menu operates on multiple selections in the Component Hierarchy 
palette. 

• When multiple components are selected in the Component Hierarchy palette, 
other General Interface Builder palettes display this behavior:

— Properties Editor palette displays properties that are common to all 
selected components, allowing you to modify these properties in a single 
step.

— Events Editor palette is active if all selected nodes are of the same class, 
allowing you to set events for multiple components.

— Attributes Editor palette displays attributes common to all selected 
components, allowing you to modify attributes in a single step. 

— XSL Parameters palette displays parameters common to all selected 
components if they are instances of Cacheable. This feature allows you to 
modify these parameters in a single step. The Name combo box is pre-filled 
only if all selected components are of the same class. 

— All palettes display the text, [multiple values], if the values for the 
selected components are different.

• Ability to set the workspace path when running the project from a local HTTP 
server (Project > Run Project From HTTP). This is useful if the relative path to 
your workspace isn’t the same on the HTTP server as on disk. To set the 
workspace path, choose Tools > IDE Settings > Paths and enter the path in 
the WS Path field.

• A new Properties Bundle editor for authoring single-file formatted, properties 
bundle files has been added for localization of strings. See Internationalization 
and Localization on page 20.
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API Changes

The new API features and improvements in 3.4 include:

Classes

• jsx3.app.PropsBundle class supports localized properties. See 
Internationalization and Localization on page 20.

• jsx3.xml.Template class replaces the deprecated jsx3.xml.Processor 
class. The Processor API isn’t compatible with persisting a compiled XSL 
template, which causes inefficiencies. 

Methods

• jsx3.gui.DatePicker.focusCalendar() - for opening a calendar.

• jsx3.gui.Dialog.constrainPosition() has been modified for 
parameterized snap behavior. This method allows you to adjust the default 32 
pixel minimum amount to be displayed for a dialog after a move.

• jsx3.gui.LayoutGrid class has new methods and properties to extend it to 
two dimensions: getRows(), setRows(), getCols(), and setCols().

• jsx3.gui.Select.doValidate() now verifies against the selectable value 
(valid jsxid in the CDF) instead of considering all non-null values to be valid.

• jsx3.xml.Entity.getAttributeNames() - returns the names of all the 
attributes of this node. More performant than using the getAttributes() 
method.

• jsx3.xml.Entity.getChildIterator() - returns an iterator that iterates 
over the child nodes of this node. More performant than 
getChildNodes().iterator(). 

• jsx3.xml.Entity.selectNodeIterator() - returns an iterator that 
iterates over the the result of an XPath query. More performant than 
selectNodes().iterator().

For more information, see TIBCO General Interface API Reference.

For deprecated APIs in 3.4, see Deprecated APIs on page 49.
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GUI Components

The new features and improvements for 3.4 GUI components include:

• Timeout limit for asynchronously loaded components is increased to 60 
seconds and is configurable. Use Model.ASYNC_LOAD_TIMEOUT to set to an 
optimal value for your deployment. See TIBCO General Interface API Reference.

• A new jsx3.gui.IFrame class and IFrame component in the Component 
Libraries palette makes it easier to use iframes with General Interface.

• Improved support for multiple selection in Tree, which includes:

— Support for range selection using Shift+click and multiple selection using 
Ctrl+click.

— Support for drag-and-drop of multiple records.

— CHANGE model event replaces the deprecated SELECT event.

— Context menu can operate on multiple rows. 

— All model events include plural forms of context variables if the action can 
occur on multiple records. For example, the strDRAGIDS context variable, 
which accepts string arrays, has been added for the DRAG event. 

• Tree supports drag-and-drop insertion between nodes and insertion as last 
child of node.

• Matrix data area now responds to the scroll wheel.

• LayoutGrid is extended to two dimensions - column and row. Use the new 
Columns Array and Rows Array properties to specify column and row size. 
See jsx3.gui.LayoutGrid in TIBCO General Interface API Reference.

• Long menus now render with auto-scroll arrows instead of with scroll bars.

• TabbedPane now provides an automatic right and left scrolling mechanism 
for navigating through tabs that are hidden when they exceed the viewable 
space. Hover over the right or left arrow icons to scroll through the hidden 
tabs. You can also navigate tabs using the right and left arrow keys.

• DatePicker event interface enhancements:

— INPUT event allows massaging of free form text input. 

— SHOW event allows the shown month to be overridden.

• Time Picker now responds to the number pad of the keyboard.
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Internationalization and Localization

The new internationalization and localization features and improvements in 3.4 
include:

• A new Properties Bundle editor for authoring single-file formatted, properties 
bundle files has been added for localization of strings. To create a properties 
bundle, choose File > New > Properties Bundle. 

• Various locales are now included in General Interface in the JSX/locale/ 
directory. 

• Five GUI controls are now internationalized in General Interface: 
DatePicker, TimePicker, Select, Menu, and Matrix. DatePicker and 
TimePicker are localized for the locales included in General Interface. 
Select, Menu, and Matrix are localized only for English

For more information, see Internationalizing and Localizing Applications in 
TIBCO General Interface Developer Guide.

Samples

Product samples have been updated to the current version. These include Chart, 
WSDL_Mapping_1, and WSDL_Mapping_2. 

More samples are available at the TIBCO Developer Network at 
http://www.generalinterface.org.

WSDL_Mapping_2

Because Xignite now requires registration for access to the service, the sample has 
been modified to run in Static mode. To receive live data, you must register with 
Xignite and modify the sample to run in Live mode.

Create a new workspace to get the updated 3.4 sample applications. Choosing an 
existing workspace doesn’t replace previous sample applications with updated 
3.4 sample applications. This built-in functionality is designed to prevent 
workspace files from getting overwritten. 
TIBCO General Interface Release Notes

http://developer.tibco.com


New Features | 21
Release 3.3
This release introduces these updates:

Web Browsers 

Browsers for Deployment

TIBCO General Interface applications and TIBCO General Interface Framework 
can be deployed to these browsers:

• Internet Explorer 7.0 and 6.0.x for Windows

• Firefox 2.0 and 1.5.x for Windows, Linux, and Mac OS X

Browsers for TIBCO General Interface Builder

TIBCO General Interface Builder runs in these browsers:

• Internet Explorer 7.0 and 6.0.x for Windows

• Firefox 2.0 and 1.5.x for Windows

TIBCO General Interface Documentation

These documents form the TIBCO General Interface documentation set:

• TIBCO General Interface Installation Read this manual for General Interface 
installation instructions.

• TIBCO General Interface Getting Started Read this manual for overview 
information and a tutorial that explains how to build a TIBCO General 
Interface application.

• TIBCO General Interface Developer Guide Refer to this manual for in-depth 
information about developing and deploying TIBCO General Interface 
applications.

• TIBCO General Interface Component Guide Refer to this manual to learn more 
about components and the Charting add-in, as well as component properties 
and events.

• TIBCO General Interface API Reference Refer to this online help content for 
descriptions of the TIBCO General Interface JavaScript API functions and 
methods.

• TIBCO General Interface Migration Read this manual for instructions on 
migrating applications from previous General Interface releases.
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• TIBCO General Interface Release Notes See this document for a list of new and 
changed features, as well as the known and closed issues for this release.

To open the documentation in TIBCO General Interface Builder, choose Help > 
Help Contents. Documentation is also available online at 
http://www.generalinterface.org.

Release 3.2
This release introduces these new features and updates:

• TIBCO Developer Network on page 22

• Web Browsers on page 22

• General Enhancements on page 23

• XML Mapping Utility on page 24

• Application Deployment on page 25

• Development Productivity on page 26

• General Interface Framework on page 28

• API Changes on page 29

• GUI Components on page 30

• Localization on page 31

• Samples on page 32

• Documentation on page 32

TIBCO Developer Network

The TIBCO Developer Network has moved to a new location. Visit 
http://www.generalinterface.org.

Web Browsers 

Browsers for Deployment

TIBCO General Interface applications and TIBCO General Interface Framework 
can be deployed to these browsers:

• Internet Explorer 6.0.x for Windows

• Firefox 1.5.x for Windows, Linux, and Mac OS X
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Browsers for TIBCO General Interface Builder

TIBCO General Interface Builder runs in these browsers:

• Internet Explorer 6.0.x for Windows

• Firefox 1.5.x for Windows

Browser Limitations

Some limitations in web browsers could restrict the kinds of applications which 
can be deployed. For known issues with browsers, see Known Issues on page 109.

General Interface APIs

Methods that are implementable only in specific browsers are specified in the 
TIBCO General Interface API documentation. Search for Firefox and Internet 
Explorer in the API documentation.

Charting Add-in

The Charting add-in is supported on these browsers and platforms in XHTML 
and HTML pages:

• Internet Explorer 6.0.x (VML) on Windows

• Firefox 1.5.x (SVG) on Mac OS X, Linux, and Windows

For supported platform versions, see readme.txt in the GI_HOME directory.

General Enhancements

General enhancements include:

• Improvements to the jsx3.gui.Select class include:

— Support for @jsxstyle and @jsximg CDF attributes

Use @jsxstyle to apply a CSS style to a record. Specify any CSS code. For 
example, jsxstyle="font-weight:bold;".

Use @jsximg to reference a graphic file to use as an icon. Specify the file 
path relative to the project directory, for example, images/icon.gif. 
Image position depends on the component. For best results, use a 16x16 
transparent GIF file.

— Vetoable Before Select model event 

• Menu hot key accelerators follow user interface guidelines for Mac OS X and 
Windows.
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• Support for the Command key on Mac OS X has been added. Actions that 
require Ctrl+click on Windows translate to Command+click on Mac OS X 
(Ctrl+click is equivalent to right-click on Mac).

• When General Interface Builder opens XSL and XML files for editing, it 
honors their encoding.

XML Mapping Utility

The XML Mapping Utility includes these enhancements:

• Re-parse part of the rules tree. To recreate deleted nodes, right-click a node in 
the Rules Tree and choose Reparse to re-parse from that node down.

• Ability to choose a specific prototype for DOM projection.

• Log messages in the Mapper Log are color coded. For example, errors are red, 
traces are gray, and so on. 

• JavaScript code generated by the XML Mapping Utility has changed due to a 
signature change in the jsx3.net.Service class. Rules files IDs are now 
passed as an argument instead of URLs. See General Interface Framework on 
page 28.

WSDL File Browsing

The XML Mapping Utility now resolves paths to WSDLs relative to the project. 
It’s recommended that you copy WSDLs to a wsdl directory in your project. Then 
enter wsdl/wsdl_file.xml in the URL field of the XML Mapping Utility. 

However, if you need to resolve a path to a WSDL outside of your project, use an 
absolute resolver, such as jsxuser:/// and jsxapp:///. 

• jsxuser:///... Resolves relative to the parent of the JSXAPPS directory, which is the 
workspace. When General Interface Builder is running, this URI resolves 
relative to the workspace directory.

• jsxapp://app/... If the Server instance corresponding to the host portion of the URI 
is loaded into memory, the URI is resolved relative to the application base 
directory (jsxappbase). 

jsx3.net.Service 

These enhancements have been made to the jsx3.net.Service class. For more 
information, see the API documentation.

• Added a new compile() method that allows the output mapping rules 
(those that handle the server's response) to be compiled into an equivalent 
XSLT document, which increases performance. This allows the Service class 
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to use the native XSLT processor as opposed to JavaScript in order to convert 
the server’s response to CDF. The Sample performance difference to convert 
400 records from SOAP to CDF is as follows: Firefox: 0.09 seconds vs 4.0 
seconds and Internet Explorer: 0.13 seconds vs 10.1 seconds. 

• Updated the doCall() method to accept a parameter, allowing the developer 
to cancel the send if the outgoing message did not pass the validation rules. 

• Updated the jsx3.net.Service.setInboundURL() and 
jsx3.net.Service.setOutboundStubURL() methods to support paths 
that are relative to the project directory.

For example, if the project directory for the context server is test, then these 
valid inputs are equivalent: 

— xml/typical.xml

— jsxapp://test/xml/typical.xml

— JSXAPPS/test/xml/typical.xml

• Added additional debug statements for more detailed debugging capabilities 
when running in trace mode. Error handling has also been expanded. Added 
a new event type that is published each time a rule in the rules file is executed, 
providing even greater control over how each node in a message is created or 
processed. 

Application Deployment

These deployment enhancements have been added:

• Accelerated load time

— Class loading improvements

Payload size is reduced as applications now dynamically load (“lazy 
loading”) only those classes which are needed. Classes now fall into three 
categories. (1) Required classes are always loaded. (2) Optional classes 
introduced in General Interface 3.2 classes are dynamically loaded. For 
example, jsx3.gui.ColorPicker. (3) Optional classes introduced prior 
to General Interface 3.2 are dynamically loaded only if the jsxlt 
deployment parameter is set to true in the web page that launches the 
application. This improves backwards compatibility. See Deployment 
Parameters in the Deploying Applications chapter of TIBCO General 
Interface Migration.

Use the jsx3.require() method to explicitly load classes synchronously. 
For example, debugger classes are now dynamically loaded and need to be 
called using the require() method. 
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jsx3.require("jsx3.ide.Debugger");

Specify the classpath to your classes on the Classpath panel of the Project 
Settings dialog (Project > Project Settings). 

— Changes to how add-ins are loaded improve the load time for TIBCO 
General Interface Builder and General Interface applications.

• Simplified portal deployment

— Separation of GI_HOME from the workspace allows for easier application 
deployment. Choose your own workspace or use the default. Modify the 
workspace directory in the Workspace field on the Paths panel of the IDE 
Settings dialog (Tools > IDE Settings).

— Application resources are specified using relative paths, which allows for 
easier portability of code from one project to another and simplifies the 
relocating of applications in the JSXAPPS folder hierarchy. 

— Applications can be loaded multiple times on a single portlet page with the 
jsxappns (namespace) deployment parameter that overrides the 
namespace in the configuration files. See Deployment Parameters in TIBCO 
General Interface Migration.

• A loading progress indicator now displays when the General Interface 
Framework loads. For multiple applications loading in the same page, only 
one indicator shows the loading of the General Interface Framework, which is 
shared by all portlet applications. Subordinate progress indicators show the 
loading of each portlet application. 

To specify the type of progress indicator displayed, add the jsxapploader 
deployment parameter to the HTML script element on the web page that 
launches the application(s). For example, setting jsxapploader=1, is a good 
choice for portlets, because this would load a subordinate progress indicator. 
See Deployment Parameters in TIBCO General Interface Migration.

Development Productivity

TIBCO General Interface Builder includes these productivity enhancements:

• The Common Interface Format (CIF) can be used to create GUI definition files 
on-the-fly or manually. The CIF format provides improved readability and 
smaller file size. TIBCO General Interface transforms these files to the current 
GUI XML structure for rendering. Currently, General Interface Builder can 
read but not save CIF files. Any edits made to a CIF file are saved in the 
standard serialization format. See Custom TIBCO General Interface Formats 
in TIBCO General Interface Migration.

• The XML/XSL Merge Tool supports opening multiple instances of the tool.
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• Reorganization of options and preferences.

— The Deployment Options dialog has been renamed to Project Settings 
dialog (Project > Project Settings). Project settings include deployment, 
add-ins, class path settings, and legacy settings.

— The Preferences dialog has been renamed to IDE Settings (Tools > IDE 
Settings). Settings include IDE settings, hot keys, and user home.

• Writing and debugging code

— The logger.xml file has been moved to the root of GI_HOME and now 
supports a configurable location. Use the environment variable, 
jsx_logger_config, in the script element of the launch page to specify 
its location. See Logging and the Application Monitor in TIBCO General 
Interface Migration.

— Color coding of messages in the System Log palette, Application Monitor, 
and the Mapper Log in the XML Mapping Utility. For example, error 
messages are displayed in red and traces in gray. 

— A configurable, optional sound can be triggered when messages are 
printed to the System Log palette. To enable sound for messages, change 
the beepLevel property in GI_HOME\logger.xml from 
jsx3.util.Logger.OFF to a message logging level, such as 
jsx3.util.Logger.ERROR. Sound is played for the specified logging 
level and higher. Firefox requires a plug-in that can play .wav files.

— JavaScript type-ahead lists (Ctrl+spacebar) are available in any code 
window and text areas with blue grid backgrounds. Type-ahead lists 
display the General Interface APIs and allow you to automatically insert 
package names, class names, methods, and fields.

— Component Hierarchy features: (1) Right-click a component and choose 
Copy Name to Clipboard to get the object name. (2) Right-click a 
component and choose Copy Getter Code to Clipboard to copy code for 
getting a handle to the object (getJSXByName).

— General Interface Builder now traps the Tab key in main stage code editors 
as 4 spaces. This is a General Interface Builder feature and does not affect 
runtime. 

— When restoring a child component from the Recycle Bin, if the parent is 
gone, the child is restored to <ROOT>.

• General Interface Builder has been rearchitected for improved load 
performance.

• General Interface Builder keyboard shortcuts can be configured in the IDE 
Settings dialog (Tools > IDE Settings > IDE Hot Keys).
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• Running General Interface Builder and projects

— Ability to launch General Interface Builder in XHTML or HTML mode. 
Choose GI_Builder.xhtml or GI_Builder.html from GI_HOME. 
Running in XHTML mode is useful for developing and testing applications 
that run in XHTML pages, such as portlet applications.

— When General Interface Builder is run in XHTML mode, an error message 
is output when the Text/Html property contains non-compliant code. 

— Choosing Project > Run Project, runs the project in the same mode as 
TIBCO General Interface Builder. For example, if General Interface Builder 
is running in XHTML mode, the project also runs in XHTML mode.

— Run your project from a local HTTP server. Choose Project > Run Project 
from HTTP. The deployed project relative path must match the local drive 
relative path to shell.html for this run option to work.

— Run Project warning displays if any open tabs have unsaved changes. A 
dialog displays a warning that some files are not saved and allows you to 
Run Without Saving, Cancel, or Save and Run. 

General Interface Framework

TIBCO General Interface Framework includes these changes:

• The persistall argument has been added to the toXML() method of the 
jsx3.app.Model class, which causes the returned serialized form to include 
DOM nodes with transient persistence. This is useful when you want to save 
the exact state of the application for troubleshooting purposes.

• Rules files IDs are now passed as an argument to jsx3.net.Service instead of URLs. 
If rules files are moved to new locations, there’s no need to update the URL, 
because the ID is used instead. The objService variable generated by the 
XML Mapping Utility has a signature change and now accepts three 
arguments: server, resource ID, and operation name. The new syntax is:

var objService = ServerName.loadResource(Project_Resource_File_Id);
objService.setOperation(Operation Name);

• The new Matrix component provides an insertBefore() method and a 
visual control for dragging and dropping multiple records to a new location.

• Instantiate CDFs directly without using a GUI control with the new 
jsx3.xml.CDF.Document class. See API Changes on page 14. 

• User-defined XSL properties, jsx1 through jsx10, have been added to 
jsx3.gui.Matrix. 

• Performance improvements to the Array.join() method instead of String 
concatenation for the String.fromBase64() and String.toBase64().
TIBCO General Interface Release Notes



New Features | 29
• The Form class provides an API that allows you to see the hidden iframe 
where the HTML for the form post is being built and where the response 
comes back from the server.

API Changes

These changes have been made to the TIBCO General Interface API. Search for 
“3.2” in TIBCO General Interface API Reference in the online help. 

• jsx3.app

— jsx3.app.AddIn A class that represents a JSX add-in. The JSX system 
creates an instance of this class for every add-in that is loaded.

— jsx3.app.Properties Represents a repository of dynamic properties. 
Dynamic properties are simply name-value pairs. Dynamic properties can 
be loaded from an XML file in the CDF dynamic property format.

• jsx3.gui

— ColorPicker A GUI class that allows the user to pick a color using an 
HSB (hue-saturation-brightness) picker. See jsx3.gui.ColorPicker in 
the API documentation.

— HotKey Encapsulates a keydown event listener that is invoked by a certain 
combination of keys pressed simultaneously.

— Image Renders an image. See jsx3.gui.Image in the API 
documentation.

— Matrix and Matrix.Column

— TimePicker

— Window Allows for rendering a branch of the DOM of an application in a 
separate browser window. This is similar to the implementation of the 
TIBCO General Interface Builder API documentation window.

• jsx3.net.Service

• jsx3.net.URIResolver interface An interface specifying the methods 
necessary to define a context against which URIs are resolved.
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• jsx3.util

— DateFormat Formats and parses dates according to a token-based string 
format. This class is fully localized. 

— Locale Represents a region of the world. Other classes may be localized, 
meaning that their behavior depends on their assigned locale.

— MessageFormat Constructs localized messages from a pattern and 
parameters. A message format takes a list of arguments, formats them, and 
inserts them into the pattern at specific places. 

— NumberFormat Formats and parses numbers.

• jsx3.xml.CDF.Document A subclass of jsx3.xml.Document that 
implements the CDF interface. This class exposes the CDF convenience 
methods on an XML document and allows you to work directly with a CDF 
document, without needing to work with a GUI list control.  Use this class for 
adding records and so on. 

• jsx3.xml.Cacheable XML Transformers replace XSL ID, XSL URL, and 
XSL String:

— getXMLTransformers()

— setXMLTransformers()

GUI Components

The classes, jsx3.gui.Grid, jsx3.gui.Column, and jsx3.gui.List, have 
been deprecated and are not supported in Firefox. The new Matrix classes, 
jsx3.gui.Matrix and jsx3.gui.Matrix.Column, have replaced the 
deprecated classes. New Matrix prototypes are available in the Component 
Libraries palette. See Deprecated APIs on page 49. 

Tree Component

The Tree prototype has been moved to the Miscellaneous folder of the Component 
Libraries palette.

Matrix Components

New Matrix components, which are composites of the List, Grid, and Tree 
components, provide richer functionality. Matrix is fully supported in Firefox and 
Internet Explorer. It’s recommended that you use Matrix instead of Grid, Column, 
and List as they have been deprecated.
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These components support such features as dynamic loading of lists for better 
performance, tree rendering of 100 levels deep, hierarchical lists that behave like 
trees, multi-column trees that behave like lists, and many other features. For more 
information, see jsx3.gui.Matrix and jsx3.gui.Matrix.Column in TIBCO 
General Interface API Reference and Using Matrix Components in TIBCO General 
Interface Migration.

Time Picker Component

The new TimePicker component, jsx3.gui.TimePicker, is a clock for selecting 
the hour, minute, and AM or PM. Seconds, milliseconds, and a 24 hour clock can 
also be displayed. This control is localized.

New GUI Controls and Behaviors

— Color Picker allows the user to pick a color using an HSB 
(hue-saturation-brightness) picker. 

— Date and Time Picker support keyboard navigation into and out of 
controls, as well as within the controls.

— Date Picker permits typing of date value into the DatePicker box as an 
alternative entry method.

— Paint methods are now XHTML compliant.

— Drop-downs for combos and selects can be wider than the unexpanded 
control. 

— Insert stack and tab children in a specific location. See these methods of the 
jsx3.app.Model class in the API documentation: insertBefore(), 
getFirstChild(), getLastChild(), getNextSibling(), and 
getPreviousSibling().

— Combo now has a maxLength property and method. 

Localization

This release includes several new localization features:

• Date, time and number formats are now externalized in the MessageFormat, 
NumberFormat and DateFormat classes. For more information, see the new 
jsx3.util API classes for localization in General Interface Framework on 
page 28.

• A new deployment option, Default Locale, for setting language and country 
codes for localizing applications. 
 TIBCO General Interface Release Notes



32 |   Release Notes
Samples

Product samples have been updated to the current version. These include Chart, 
WSDL_Mapping_1, and WSDL_Mapping_2. 

More samples are available at the TIBCO Developer Network at 
http://www.generalinterface.org.

Documentation

This release includes these changes to documentation:

• TIBCO General Interface Builder GUI Reference has been updated and included 
in this release.

• TIBCO General Interface Builder Chart User’s Guide: 

— Chapter 1, Working with Charts, has been moved to TIBCO General Interface 
Builder Getting Started Guide.

— Chapter 2, Chart Components, has been moved to TIBCO General Interface 
Builder GUI Reference. 

— TIBCO General Interface Builder Chart User’s Guide has been removed.

• Class property descriptions have been added to the Properties Editor palette. 
Hover over a property, such as Padding, to see a description of it in the 
spyglass.

Release 3.1.1
This release introduces these enhancements: 

• The XML Mapping Utility’s Generate Code button is now a menu button, 
which introspects for the available operations. If the rule file has not been 
saved, selecting an operation triggers an alert which says to save the file. Only 
when the rule file has been saved does the code generator put the code on the 
clipboard and alert the user to paste the code to the desired location.

• The signature for the Model.loadXML() method now accepts 
jsx3.xml.Document as well as string. Without this method the developer 
cannot pre-cache GUI components in the cache to avoid run-time reloading.

Choosing an existing workspace doesn’t replace previous sample applications 
with updated 3.2 sample applications. This built-in functionality is designed to 
prevent workspace files from getting overwritten. Create a new workspace to get 
the updated sample applications. 
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Release 3.1
This release introduces a wide variety of new features in these categories: 

• XML Mapping Utility on page 33

• Package Reorganization on page 34

• Usability Enhancements on page 36

• Logging on page 37

• Event Model on page 37

• GUI Components on page 37

• Help on page 39

XML Mapping Utility

• Expanded support, including: 

— WSDL (Document-Literal and RPC-Encoded) 

— Schema (2001) 

— XML/XHTML (including RSS, REST, and so on) 

• Step-through tester with detailed logging, describing each node as it is 
processed by the XML Mapping Utility.

• Automatic UI projection. Fields described in a WSDL (or any other source 
format) can be leveraged by the XML Mapping Utility to create the 
auto-generate the GUI.

• Improved logging support with detailed information about why a mapping 
may have failed, including unsupported schema nodes, malformed XML, 
improper imports, and so on. 

• Support for offline testing and configuration, allowing the mappings to be 
built and tested without accessing the live services.

• Automatic migration of 3.0 maps to the new 3.1 format.

• Test message generator, capable of simulating the live service.

See the TIBCO General Interface Builder Getting Started Guide for information on 
many of these features.
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Package Reorganization

jsx3 The jsx3 package contains the deprecated classes from General Interface 3.0. 
Most of these classes have been moved into one of these packages: app, gui, net, 
util, and xml. These classes can still be referred to by their old names; however 
this is deprecated and not guaranteed to work in future versions.

jsx3.app The jsx3.app package contains classes related to General Interface applications. 
Classes in this package are used extensively in application JavaScript code. 

The Server class is the controller in the JSX architecture. An instance of this class 
is created by the JSX runtime for each loaded application. Server provides access 
to the application DOM (getRootBlock(), getDOM(), getJSX(), and so on), the 
application cache (getCache()), and application settings (getSettings()).

The Monitor class, new in 3.1, is a vital tool in debugging running applications. It 
brings the power of the TIBCO General Interface Builder system log to running 
applications by displaying logging messages in a separate browser window.

jsx3.chart The jsx3.chart package contains all the classes contained in the General 
Interface Charting add-in. It provides a collection of GUI controls that render 
charts, such as bar, column, area, line, plot, bubble, pie, and doughnut.

The General Interface Charting add-in provides these features:

• Prototype charts effortlessly in TIBCO General Interface Builder, just like any 
other GUI control

• Render from any standard CDF data source as a chart

• A rich event model for implementing interactive charts

• Offload chart rendering to the client browser, no plug-in required

jsx3.gui The jsx3.gui package contains all the GUI controls available by default in the 
JSX runtime. Classes in this package are typically not instantiated by the 
developer. Rather they are prototyped in TIBCO General Interface Builder, 
serialized to component files, and deserialized at application runtime by the JSX 
runtime. TIBCO General Interface Builder provides at least one prototype for each 
class in this package.

General Interface 3.1 contains these new GUI controls:

• ImageButton A simple button class comprised of a separate image file for 
each state of the button.

• Slider  A form control comprised of a track and a handler that is draggable 
along the track.

• Sound Provides a standard interface for playing sounds of different formats.
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jsx3.lang The jsx3.lang package contains the classes that comprise the General Interface 
class, inheritance, and introspection model. This model, introduced in General 
Interface 3.1, extends JavaScript 1.5 with these features:

• A simple syntax for declaring classes, with support for “extends” and 
“implements”

• Mixin interfaces

• An extended base class, jsx3.lang.Object, from which all other classes 
descend

• Fully introspectable classes, interfaces, packages, and methods

• A base exception class, jsx3.lang.Exception, with stack tracing facilities

• Access to the overridden method determined by context, with the 
jsxsuper() and jsxsupermix() methods

Developers who use this package, rather than the typical facilities provided by 
JavaScript 1.5 to define custom classes will tap the significant developer-friendly 
features provided by this package.

jsx3.net The jsx3.net package contains various classes related to HTTP communication. 
Applications that use the data mapper and/or communicate with web services or 
legacy HTTP forms will use the classes in this package extensively.

Form allows a General Interface application to submit to legacy HTTP forms by 
either GET or POST and allows for file upload to such forms. Request is a 
platform independent wrapper of the browser XMLHTTP control. It allows any 
XML data source to be fetched either synchronously or asynchronously. Service 
is the programmatic interface onto the data mapping utility. URI is a simple utility 
class that is useful for parsing and resolving URIs. 

jsx3.util The jsx3.util package contains various utility classes.

EventDispatcher is a mixin interface that when implemented by a class 
provides functionality according to the publish-subscribe design pattern. The 
Logger class, new in General Interface 3.1, is the primary interface of the General 
Interface logging system. 

jsx3.xml The jsx3.xml package contains various classes related to XML processing. 

The Document, Entity, and Processor classes provide platform independent 
interfaces onto the native browser XML DOM and XSLT libraries. CDF is a mixin 
interface, implemented by all CDF GUI controls, that provides an object-oriented 
interface onto the CDF XML format. Cacheable, also implemented by many GUI 
controls, is a mixin interface that provides functionality related to fetching and 
storing XML and XSL documents in the application cache.
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Usability Enhancements

• TIBCO General Interface Builder can now be launched using 
GI_Builder.hta file in GI_HOME. When launched using this file, the browser 
menus and browser toolbars are hidden, leaving maximum screen area for 
development tasks.

• Tree components now support selecting multiple nodes. A new Multi-Select 
property for enabling or disabling this feature was added. When the property 
is set to Multi-Select, users can press the Ctrl+click to select multiple nodes in 
the hierarchy. 

This change also allows you to select multiple items in the Local Data Cache 
palette and Project Files palette in TIBCO General Interface Builder, as well as 
the Rules Tree in the XML Mapping Utility.

• Palette features The XSL Parameters and Attributes Editor palettes are now 
hidden by default. You can display these palettes by manually selecting them 
in the Palettes menu.

The state and position of floating palettes is now stored as a project setting in 
TIBCO General Interface Builder, and preserved across project sessions. If a 
palette is floating when a project is closed, when the project is reopened the 
palette is still floating in the same position.

Projects

• TIBCO General Interface Builder projects can now be located in subfolders. In 
the Create New Project dialog, specify the project name as 
project_path/project_name, where project_path is one or more directory names 
under the GI_HOME/JSXAPPS directory. Separate directory names with 
forward slash characters (/).

• A new option for specifying whether TIBCO General Interface Builder 
automatically opens the last project on startup was added to Tools menu.

• Project files that begin with the string jsx are now supported in TIBCO 
General Interface Builder.

• A new Watermark field for moving the Powered By TIBCO text string to the 
left, center, or right side of your application window was added to the Project 
Deployment Options dialog.
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Logging

This release contains a new logging system defined in the jsx3.util.Logger 
class and a new jsx3.app.Monitor class for displaying logging messages in a 
separate browser window. For details, see the online API help in TIBCO General 
Interface Builder.

For more information and code samples, check the TIBCO General Interface 
Developer Community at http://www.generalinterface.org. See the document 
Advanced Logging.

Event Model

This release introduces significant changes to the way that application 
components handle events. The global event object (jsx3.EVENT) is deprecated. 
For API calls and user interactions that interact with events, the new model 
requires explicitly passing the event object, an instance of jsx3.gui.Event. For 
more information and code samples, check the TIBCO General Interface 
Developer Community at http://www.generalinterface.org. See the document 
Model Events.

These changes are implemented in a backward-compatible manner, so that 
immediate migration is not necessary. Existing projects and applications run 
seamlessly without modification. However, new projects use the new event 
protocol unless the Event Protocol field is set to 3.0 in the Deployment Options 
dialog.

GUI Components

• TextBox and Password prototype components have a new Max Length 
property for specifying the maximum number of characters a user can type in 
a text box or password field.

• Select and Combo components support for the XSL attribute 
jsxshallowfrom for specifying a portion of a CDF structure to render in the 
component. Previously, any hierarchy information in CDF data was not 
shown by these components. You can add this parameter using the XSL 
Parameters palette, which can be accessed using the Palettes menu. To display 
only CDF records that are children of the root element, specify jsxroot.

• Tree components support a new jsxdeepfrom XSL parameter for specifying 
the jsxid value of the first visible node in the tree. All descendants of this 
node are also displayed, while the root node remains hidden.

• Support for the insertHTML method was added to the jsx3.gui.Stack and 
jsx3.gui.StackGroup classes for more efficient painting.
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• Select and Combo components now support the jsxtip system attribute in 
the CDF document. This attribute provides tooltip text when the user hovers 
the mouse cursor over the component.

• The Block and BlockX components now support a double-click event, which 
allows images and labels to be used as buttons. The setTip() method was 
also enhanced to automatically repaint tooltip text. For information on 
descendant components, see the description of jsx3.gui.Block in the online 
API help.

• A new class, jsx3.gui.ImageButton, was added with support for image 
rollover, and for relevant events. A different image can be used for each 
button state. For details, see the class description in the online API help.

• Other new API classes in this release include jsx3.util.Sound and 
jsx3.gui.Event.

• List and Grid components The List and Grid prototype components have been 
enhanced as follows:

— New events The Before Sort and After Sort events fire just before or after a 
user sorts the contents of a List or Grid component. Before Sort also allows 
the index value of the clicked column to be modified before the data is 
sorted. After Sort can be used to perform cleanup tasks after data is 
repainted.

Similarly, the Before Resize and After Resize events fire when a user resizes 
the component. Resizing a component with many data rows can be 
canceled, or on-screen dimensions can be modified to optimize the display.

— Attributes for XSL parameters Support for 4 new XSL attributes was added. 
You can add these parameters using the XSL Parameters palette, which can 
be accessed using the Palettes menu.

jsxshallowfrom allows you to specify a portion of a CDF structure for 
rendering in non-hierarchical GUI components, such as List and Grid. 
Previously, any hierarchy information in CDF data was not shown by these 
components. Specify the name of the immediate parent element for this 
attribute. To display only CDF records that are children of the root element, 
specify jsxroot.

jsxbg1 allows you to specify the background color of odd-numbered 
rows, beginning with the first row. jsxbg2 allows you to specify the 
background color of even-numbered rows, beginning with the second row.

jsxstyle allows you to specify any valid CSS style for a record. Only the 
record that includes this attribute uses the specified style.
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• Additional checkbox state CheckBox components can be selected, unselected, 
or partially selected. The new partially selected state can be programmatically 
set, for example to select a parent object in a nested list when a child object is 
explicitly selected. To indicate the partial selection state, the checkbox displays 
a minus sign (-) character.

• Select and Combo components The tab and arrow keys can now be used to 
navigate in the list of values and select a value. The type-ahead feature can be 
used for narrowing the list of values in a Combo component, provided the 
jsxid and jsxtext attributes have identical values in the CDF file used by 
the component.

• Slider component  A new class, jsx3.gui.Slider and a new prototype 
component, Slider (H) were added. Use a slider to allow users to set a 
numerical value in a defined range. Clicking in the slider bar moves the 
handle to the clicked location. Dragging the handle changes the slider value.

• API methods for masking The showMask and hideMask methods were added 
to the jsx3.gui.Block class. These methods can be used to hide or disable 
any area of the screen. An optional message can be displayed.

Help

• A link to information on writing regular expressions was added to the Help 
menu in TIBCO General Interface Builder. To access this web page, select 
Help > Internet Resources > Regular Expressions Guide.

• API reference

— Better visibility of JavaScript native functions, navigable type links, and 
automatic search cancellation when the window is closed during a search 
operation.

— A menu in the API help window was added with a existing option, Show 
Inherited Members, and a new option, Show Deprecated Classes and 
Members.

— An HTML version, displaying in a separate browser window, is now 
available.
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Changes in Functionality

This section discusses changes in functionality since the last major release of this 
product.

Release 3.9.1
There are no changes in functionality for this release.

Release 3.9
The General Interface Builder built-in debugger for Internet Explorer has been 
removed.

Release 3.8
There are no changes in functionality in this release.

Release 3.7.1
The behavior of URIResolver.getResolver("JSXAPPS/...") has reverted 
back to the behavior in Release 3.5.

In Release 3.6, URIResolver.getResolver("JSXAPPS/...") returned 
URIResolver.USER rather than URIResolver.DEFAULT. As a result, projects 
that mixed JSXAPPS/... and project-relative URIs did not function in Release 
3.6. Moreover, deployment layouts in which the launch page and JSXAPPS/ were 
siblings did not work properly. 

The default behavior in Release 3.7.1 matches that of Release 3.5. If you require 
Release 3.6-3.7.0 behavior, use the system deployment parameter, 
jsxurirslv="3.6", which turns on the Release 3.6 behavior. For information on 
system deployment parameters, see the TIBCO General Interface Developer Guide, 
Release 3.7.

Release 3.7.0
General Interface 3.4 includes the following changes in functionality.

Type-Ahead

The type-ahead feature is no longer provided in the script , XML and XSL editors.
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meta.xml

The <resourcename>.meta.xml file functionality has been dropped in General 
Interface 3.6/3.7, so that localized applications that use the file will fail to display 
localized text.

If you use <resourcename>.meta.xml in your application, update the 
application to add the locales specification in the main resource properties file.

For example:

<data jsxid="jsxroot" jsxnamespace="propsbundle"
locales="fr,zh_TW">
<locale>
<record jsxid="Line1" jsxtext="This old village" 
type="jsxtext"/>
<record jsxid="Line2" jsxtext="not a single house" 
type="jsxtext"/>
<record jsxid="Line3" jsxtext="without persimmon trees" 
type="jsxtext"/>
<record jsxid="Dialog1" jsxtext="Dialog Title (No Chinese or 
French value available)" type="jsxtext"/>
<record jsxid="Tools1" jsxtext="Tools" type="jsxtext"/>
<record jsxid="Display English" jsxtext="Display English"/>
<record jsxid="Display Chinese" jsxtext="Display Chinese"/>
<record jsxid="Display French" jsxtext="Display French"/>
<record jsxid="Display Default" jsxtext="Display Default"/>
<!-- demonstrates fall-through >
</locale>
</data> 

Release 3.6.2
There are no changes in functionality for this release.

Release 3.6.1
There are no changes in functionality for this release.

Release 3.6
There are no changes in functionality for this release.
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Release 3.5.1
There are no changes in functionality for this release.

Release 3.5
There are no changes in functionality for this release.

Release 3.4.1
There are no changes in functionality for this release.

Release 3.4
General Interface 3.4 includes the following changes in functionality.

Application Deployment

This deployment feature has been removed in 3.4.

Release 3.3
In some versions of Internet Explorer 6 and 7, XML, XSL, and component 
serialization files may not always be refetched from an HTTP/S server even if 
they have changed on the server. 

For more information on Internet Explorer caching and best practices, see 
“Understanding Internet Explorer Caching” at http://www.generalinterface.org 
in the Tips and Techniques section.

Release 3.2
Every effort has been made to provide backward compatibility from General 
Interface 3.2 to 3.1. However, some migration steps are required. For migration 
instructions, see TIBCO General Interface Migration.

TIBCO General Interface Framework

• For more flexibility in project deployment, these changes have been made:

— Projects are now saved to a workspace directory. The workspace is the 
directory that contains your projects, custom add-ins, custom prototypes, 
and your user settings for General Interface Builder. You can create a new 
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workspace, choose an existing directory, or use the default directory. To 
change the workspace, choose Tools > IDE Settings > Paths and specify 
the path in the Workspace field. 

— The launch page and JSXAPPS and JSX folders can each be in any location 
on the server. 

See Application Deployment on page 25.

• Debugging

— Debugger classes are now dynamically loaded. You must use the 
jsx3.require() method before any jsx3.ide.debug() statements to 
load debugger classes. For example, 

jsx3.require("jsx3.ide.Debugger");

• Add-ins

To accelerate TIBCO General Interface Builder and TIBCO General Interface 
application load time, add-ins are only loaded when required.

— By default, add-ins, such as Charting, are no longer loaded automatically. 
Add-ins must be enabled in the project to have access to those features. To 
enable add-ins, choose Project > Project Settings > Add-ins. Select the 
add-in, Save, and restart TIBCO General Interface Builder. 

— The Mapping add-in is always available and doesn’t need to be enabled in 
the Project Settings dialog. 

— An addin directory has been added to the workspace for storing any 
custom add-ins you create. These add-ins aren’t loaded unless enabled in 
the project.

• How some properties are specified has changed. Left, Top, Width, and Height 
properties can be specified in implied pixels or in percentages. Padding, 
Margin, and Border properties have also been updated. Use the abbreviated 
TIBCO General Interface syntax for better performance or use the CSS2 
syntax. See Entering CSS Values in TIBCO General Interface Migration.

TIBCO General Interface Builder

The Deployment Options dialog and the Preferences dialog have been renamed 
and some new options added. 

Release 3.1.1
There are no changes in functionality for this release.
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Release 3.1
Every effort has been made to provide backward compatibility from General 
Interface 3.1 to 3.0. In most cases applications will work with no changes. For 
more information on migrating 3.0 projects to 3.1, see Migrating 3.0 Applications to 
3.1 on the TIBCO Developer Network web site at 
http://www.generalinterface.org.
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Deprecated Features

This section describes deprecated features and lists equivalent features that 
accomplish the same result, if relevant. Any use of a deprecated feature should be 
discontinued as it may be removed in a future release. You should avoid 
becoming dependent on deprecated features and become familiar with the 
equivalent feature.

Release 3.9.2
Deprecated browsers and features:

• Internet Explorer 6 and 7 are deprecated (IE 8 and 9 are still supported).

• GI Builder IDE for Firefox is deprecated (GI Builder is supported on IE 8-11).

• GI Builder IDE for Firefox requires Firefox 10ESR or Firefox 12.

• Dojo integration has been deprecated. The gi-3.9.2-Dojo package is supported 
only on IE9 and lower.

Release 3.9.1
There are no deprecated features in this release.

Release 3.9
The following browsers are deprecated in this release:

• Firefox 2.0, 1.5

• Chrome 3.0, 2.0

• Internet Explorer 6.0

• Safari 3.1 on Mac OSX

• Safari 3.2, 3.1 on Windows

Release 3.8
There are no deprecated features in this release.
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Release 3.7.1
There are no deprecated features in this release.

Release 3.7.0
There are no deprecated features in this release.

Release 3.6.2
There are no deprecated features in this release.

Release 3.6.1
There are no deprecated features in this release.

Release 3.6
The <resourcename>.meta.xml file functionality has been dropped in this 
release.

Release 3.5.1
This feature is deprecated in this release:

• get/setSelectionLanguage is deprecated, as it only applies to Internet 
Explorer.

Release 3.5
This feature is deprecated in this release.

Deprecated APIs

These APIs are deprecated in 3.5. For more information, see TIBCO General 
Interface API Reference.

• jsx3.gui.Menu.clearCachedContent()

• jsx3.gui.Select.DEFAULTBACKGROUNDCOLOR

If your localized application uses the <resourcename>.meta.xml file, you must 
modify the application to enable localized text to display. See the General 
Interface Migration Guide for instructions on how to modify your application.
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Release 3.4.1
There are no deprecated features in this release.

Release 3.4
This feature is deprecated in the 3.4 release:

• SELECT event for Tree is deprecated and replaced with the CHANGE model 
event.

Deprecated APIs

These APIs are deprecated in 3.4. For more information, see TIBCO General 
Interface API Reference.

Deprecated Classes

• jsx3.xml.Processor - use jsx3.xml.Template 

Deprecated Fields

• jsx3.app.Settings.DOMAIN_SYSTEM

• jsx3.gui.LayoutGrid.ABSOLUTE

• jsx3.gui.LayoutGrid.ADAPTIVE

• jsx3.gui.LayoutGrid.DEFAULTDIMENSIONS

• jsx3.gui.LayoutGrid.DEFAULTORIENTATION

• jsx3.gui.LayoutGrid.DEFAULTREPEAT

• jsx3.gui.LayoutGrid.ORIENTATIONCOL

• jsx3.gui.LayoutGrid.ORIENTATIONROW

• jsx3.gui.List.DEFAULTXSLURL

• jsx3.gui.Matrix.DEFAULT_INFO_LABEL - value is now localized

• jsx3.gui.Matrix.DEFAULT_XSL_URL - renamed to DEFAULTXSLURL 

• jsx3.gui.Menu.DEFAULTXSLCACHEID

• jsx3.gui.Menu.NODATAMESSAGE

• jsx3.gui.Select.COMBOXSLID

• jsx3.gui.Select.COMBOXSLURL - renamed to DEFAULTXSLURL

• jsx3.gui.Select.SELECTXSLID

• jsx3.gui.Select.SELECTXSLURL - renamed to DEFAULTXSLURL
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• jsx3.gui.StackGroup.DEFAULTDIMENSIONS

• jsx3.gui.StackGroup.DEFAULTSTACKCOUNT

• jsx3.gui.Tab.DEFAULTHIGHLIGHT

• jsx3.gui.Tab.DEFAULTSHADOW

• jsx3.gui.TextBox.OVERFLOWAUTO

• jsx3.gui.TextBox.OVERFLOWNORMAL

• jsx3.gui.TextBox.OVERFLOWSCROLL

• jsx3.gui.Tree.DEFAULTXSLID

• jsx3.gui.Tree.ONDROPBGIMAGE

• jsx3.xml.Cacheable.DEFAULTXSLCACHEID 

Deprecated Methods

• jsx3.gui.LayoutGrid.getBestGuess()

• jsx3.gui.LayoutGrid.getDimensionArray() - use getRows() and 
getCols() 

• jsx3.gui.LayoutGrid.getOrientation() - use getRows() and 
getCols()

• jsx3.gui.LayoutGrid.getRepeat() 

• jsx3.gui.LayoutGrid.setBestGuess()

• jsx3.gui.LayoutGrid.setDimensionArray() - use setRows() and 
setCols()

• jsx3.gui.LayoutGrid.setOrientation() - use setRows() and 
setCols()

• jsx3.gui.LayoutGrid.setRepeat() 

• jsx3.gui.Tree.getText()

• jsx3.net.Request.getReadyState() - use the event publisher interface 
instead to track the state of the request. 

• jsx3.xml.Entity.getXML() - use toString() 

Release 3.3
There are no deprecated features in this release.

Release 3.2
The following features are deprecated in this release.
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Deprecated APIs

These APIs are deprecated in 3.2:

• These jsx3.xml.Cacheable properties are deprecated: 

— XSL URL getters and setters

— XSL ID getters and setters

— XSL String getters and setters

Instead of these properties, use the XML transformers functionality: 
getXMLTransformers() and setXMLTransformers().

• jsx3.gui.insertHTML()is replaced by paintChild()

Deprecated Prototypes

Grid, List, Column, and MultiSelect have been deprecated and moved to the 
Deprecated folder in the Component Libraries palette. Matrix and Matrix 
Column components replace Grid, List, and Column. 

Release 3.1.1
There are no deprecated features in this release.

Release 3.1
These features are deprecated in this release:

• Class Structure The class hierarchy has been completely reorganized in this 
release. This has resulted in the deprecation of many classes. Refer to the API 
documentation for the list of deprecated classes and their replacements. 

• jsx3.out is replaced by jsx3.log() and class jsx3.util.Logger. For 
information on these features, see General Interface Logging at the TIBCO 
Developer Network web site at http://www.generalinterface.org.

• Event Model Static access to the current event object (jsx3.EVENT) was 
deprecated. In addition, in order to support both the 3.0 and 3.1 model event 
protocols simultaneously, many methods have been either deprecated or 
made to branch based on which event protocol is in use. Methods have been 
deprecated or renamed when they existed solely to generate a model event or 
when their names implied that they generated a model event. Preexisting 
methods that have different behavior based on the model event protocol are 
considered branching methods. For more information, see Model Events on the 
TIBCO Developer Network web site at http://www.generalinterface.org.
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• Various Methods and Fields Consult the API documentation in General 
Interface Builder Help for other deprecated methods and fields. Deprecated 
members are indicated with a strike-through font.
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Migration and Compatibility

To migrate projects from previous General Interface releases, see TIBCO General 
Interface Migration in the General Interface documentation.
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Closed Issues

The tables in this section list issues that were closed in the named releases.

Asynchronous Modular Platform

Closed in 
Release

JIRA # Defect # Summary

3.9.1 GI-914 <subscribe when="load"> not compatible with 
"handler" attribute for no good reason.

3.9.1 GI-837 Inline propsbundle in AMP plugin.xml is broken due to 
typo.

3.9 GI-781 Deregistering a plug-in should not deregister 
extensions in other plug-ins.

3.9 GI-714 Provide support to create an extension-point/extension 
dynamically at runtime as follows:

(extPoint) plugin.addExtPoint(<String> 
localId, <jsx3.xml.Entity> objXMLElement, 
<jsx3.lang.Class>jsxclass);

(ext) plugin.addExt(<String>localId, 
<String>pointId, <jsx3.xml.Entity> 
objXMLElement, <jsx3.lang.Class>jsxclass);

3.8.0 GI-544 Extensions of auto-registered and manually-registered 
plug-ins should be ordered correctly.

3.7.1 GI-515 JavaScript resources inlined by AMP build tools should 
be evaluated once, not for each application.

3.7.1 GI-514 1-9QWIO7 Instead of failing silently, AMP should log proper error 
messages if a required plug-in is not already registered.
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Charting

Closed in 
Release JIRA # Defect # Summary (Sheet 1 of 2)

3.9.2 GI-1000 IE11 charting sample event chart fails.

3.9.1 GI-925 IE9 should use the SVG implementation of charting.

3.9.1 GI-912 Charts not compatible with IE8 + Standards mode 
(HTML5/XHTML doctype).

3.9.1 GI-883 Send record index as well as value to 
Axis.labelFunction

3.8.0 GI-545 CSS rules do not work in charting in Firefox or Safari.

3.8.0 GI-549 Application code may load before add-in code when 
multiple applications require the same add-in.

3.7.0 1-9D1MPB When the chart title color is changed, it takes effect 
only when the bgcolor property changes. In 3.5, the 
change in title color took effect immediately. 

3.7.0 GI-412 1-9KW3QL The function assigned to 
colorFunction/tooltipFunction for 
jsx3.chart.BarSeries (and others) cannot have 
closures in it. It is also always evaluated in the context 
of window. This restricts its usefulness. 

3.5.0 1-8CK43C Changing the type of Area chart from 'Overlay' to any 
other Stacked or Stacked 100% property threw an 
error.

3.3.0 1-7XM18V Any change to a chart’s axis property that resulted in 
a negative computed value of the axis Left position 
ran the risk of generating -1INF (negative infinity) on 
Internet Explorer. 

This caused deserialization to fail.
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3.1.1 1-6YXIXS Events on chart series (and possibly other chart 
components) fired twice. The event handlers were 
incorrectly painted in the group containing the 
category shapes. 

They should have only been painted in the category 
shapes themselves.

3.1.0 1-5ZWDAG When an empty area chart was created, an error was 
generated. 

This error occurred when there wasn’t any data to 
display on chart axes.

Closed in 
Release JIRA # Defect # Summary (Sheet 2 of 2)
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Data Mapping Tools

Closed in 
Release

JIRA # Defect # Summary (Sheet 1 of 6)

3.9.2 GI-979 Bad mapping rule with unnamed CDF document can cause 
NPE on service request fault handling.

3.9.1 GI-853 jsx3.net.Service doesn't publish ON_ERROR event in JSON.

3.9 1-A6JKAE If the WSDL contains xsd:group elements, then the web 
service invocation fails with the "Object required" exception.

3.9 GI-449 Clicking on WSDL method name in mapper throws an error 
in XHTML mode.

3.8.0 GI-404 WSDL minOccurs constraint is not taken into account for 
referenced elements.

3.8.0 GI-556 1-A0SXE9 When using the XML/XHTML/Schema option in Mapper, 
the operation is not available in the Tester utility. "Data 
Unavailable" is displayed in the Operations list, so it is not 
possible to test the mapping rule.

3.8.0 GI-587 The mapper does not apply a targetNamespace when 
targeting a referenced schema element (for example, 
<element ref="someElement"/>).

3.7.1 GI-526 Compiling a mapping rule with recursion fails if the recurse 
node and its target node do not share the same node name.

3.7.0 1-85E4XS GI Mapper now supports deeply nested WSDL and schema 
imports.

3.7.0 1-9EH74Z When a WSDL is RPC Literal, the mapper incorrectly ignored 
the part/@element attribute. Instead, it only looked for the 
part/@type attribute. Both element and type attributes can 
now be used to define the message parameters. 

3.6.2 GI-406 1-9AV3T9 CDF binding of matrix controls does not work when the CDF 
is changed by the Data Mapper.

3.6.0 GI-303 1-93ACWZ The mapping utility incorrectly parses the WSDL schema if a 
"ref" tag is used and if the referenced element in the target 
namespace is not namespace qualified. 
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3.6.0 1-8RUEMP Validation did not fail on_invalid, when restriction type 
was set to minLength.

3.5.1 GI-239 1-8EBIR7 Double-clicking a rule in the data mapping utility would 
cause a null pointer exception if the given rule was not 
generated using a WSDL or a schema source document.

3.5.0 GI-154 1-8DBUEO RULENODE variable not available in outbound rules.

3.5.0 1-8D2BON These namespace-related bugs were fixed in the XML 
Mapping Utility and Service class: 

1. The 'xml' namespace prefix was not handled correctly. If, 
for example, a document used this prefix to point to the 
implicitly-declared namespace, 
“http://www.w3.org/XML/1998/namespace” , the 
Service class was unable to generate the appropriate 
markup, because it explicitly declared the namespace 
(which is wrong).

2. If a mapping rule did not use a stub document and the 
mapping rule had an attribute on the root node and if that 
attribute was assigned to a particular namespace, then the 
Service class would create a duplicate namespace 
declaration on the root node when generating the input 
message.

3. If the XML Mapping Utility parsed an XML document 
and that document used a qualified namespace on a given 
node and if that node also declared an unqualified 
namespace, the unqualified namespace was improperly 
assigned to the node, overwriting the namespace it 
actually should have used.

3.5.0 1-8CNHKB The XML Mapping Utility and the Service class didn’t 
support recursive rules, meaning deeply nested messages 
were difficult, if not impossible, to map. 

3.4.1 GI-131 1-88F61H Restrictions set on input parameters were also set incorrectly 
on the parent node when the WSDL was parsed in the XML 
Mapping Utility. 

3.4.1 GI-130 1-88F1AJ Reparsing a modified node in a WSDL failed if the original 
order of nodes was changed.

Closed in 
Release

JIRA # Defect # Summary (Sheet 2 of 6)
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3.4.1 GI-124 1-87V8N9 The reparse feature for the XML Mapping Utility was broken.

3.4.0 GI-87 1-81TP0D The XML Mapping Utility was encoding soap messages that 
define a soap encoding style even if their 'use' was 'literal'. 
Instead, the XML Mapping Utility should only encode 
messages when both the encoding style is specified AND the 
'use' is 'encoded'.

Note: You can now edit the SOAP Use (encoded or literal) and 
the SOAP Encoding 
(http://schemas.xmlsoap.org/soap/encoding/) fields in the 
Rule Profile panel of the XML Mapping Utility. 

See XML Mapping Utility on page 12.

3.4.0 GI-65 1-80VDDB The XML Mapping Utility method, 
getTargetedSchemaQuery(), was improperly including 
schemas in its search scope. This problem occurred when a 
WSDL was parsed that had these characteristics:

• it included multiple schemas

• a following schema had an import child that referenced 
the namespace for a previous schema

3.4.0 1-7TRW5X The Types drop-down list in the Mapping table didn’t display 
when you clicked the drop-down arrow the first time. Also, 
the jsxnull ID displayed as the first item in the list instead of 
-Select-.

Closed in 
Release

JIRA # Defect # Summary (Sheet 3 of 6)
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3.4.0 1-7GUVAT Parsing a WSDL with SOAP version 1.2 using the XML 
Mapping Utility resulted in this misleading error message:

[ERROR] The WSDL located at 
'JSX/addins/mapping/samples/ldap-bw.wsdl' does 
not contain any soap bindings (i.e., 
'/wsdl:definitions/wsdl:service/wsdl:port/soap:
address'). Abstract WSDLs as well as protocols 
such as FTP and HTTP are not supported at this 
time.

Because the XML Mapping Utility doesn’t support SOAP 
version 1.2, the error message was modified as follows:

The WSDL located at '{wsdl_url}' does not contain a 
valid reference to a supported version of SOAP. At this time 
only this namespace is supported: 
'http://schemas.xmlsoap.org/wsdl/soap/'.

3.3.0 1-7X3AN7 The jsx3.net.Service class was improperly sending the 
string value 'null' when a CDF attribute mapping was 
generating a value in the outgoing request. 

If the CDF attribute node was missing, no value should be 
set. If the CDF attribute node was an empty string, the value 
should be an empty string. 

3.3.0 1-7X3AFK The doCall() method for the jsx3.net.Service class 
failed to include the XML prolog when sending request 
documents. This wasn’t standard and could cause the request 
to be mishandled by the receiving server. 

The prolog should include <?xml version="1.0" ?>, 
should be sent with doCall() requests, and should also 
appear when using the Test Interface in the XML Mapping 
Utility (panel 2 in the Test Interface).

3.3.0 1-7VF6FY When the XML Mapping Utility parsed an XML document 
(not a WSDL), the xmlns nodes in the pattern master were 
persisted as CXF rules. 

The xmlns nodes should have been ignored and not persisted 
as rules. This was incorrect and broke the service class when 
the given ruleset was run. 

Closed in 
Release

JIRA # Defect # Summary (Sheet 4 of 6)
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3.3.0 1-7VF6EC When the XML Mapping Utility parsed a WSDL that 
contained a schema-defined node with the nillable 
attribute, the attribute wasn’t honored. 

The nillable attribute, if explicitly declared, should have 
been added to the list of restrictions for the given node when 
it was first parsed by the XML Mapping Utility.

3.3.0 1-7VF6D9 SOAP messages that didn’t define a soap:operation node 
in the WSDL caused a null pointer exception in the XML 
Mapping Utility. 

The XML Mapping Utility needed to allow messages that 
didn’t contain this node and continue parsing.

3.3.0 1-7C0PJX Nodes were missing in the XML Mapping Utility. This 
occurred when a WSDL referenced a schema, which in turn 
referenced another schema. The XML Mapping Utility didn’t 
support this feature and the behavior was as expected. 

The xsd:extension element won’t properly parse if the 
element was based upon an xsd:extension element that 
was based upon yet another xsd:extension element. 

3.2.0 1-79SFGL No alert occurred when the XML Mapping Utility tried to 
parse a mapping file that didn’t exist. 

The error message reported that the type was unrecognized 
when it should have reported the file wasn’t found. 

3.2.0 1-76D12H Added support to the XML Mapping Utility to handle 
WSDLs created by BW 5.3.2. 

3.2.0 1-768GLZ Static service calls using setInboundURL() and 
setOutboundURL() don’t work. 

For Inbound mappings to run, the HTTP status code must be 
200, 202, or 0. This affected the Service class when running 
in test/static mode. 

3.2.0 1-72BKSN The XML Mapping Utility didn’t account for different 
namespaces when the element name was the same. 

Closed in 
Release

JIRA # Defect # Summary (Sheet 5 of 6)
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Deployment

3.2.0 1-71UVED The XML Mapping Utility ignored locally declared 
namespaces (those namespaces declared on a node), so it 
failed to see the data type for the part.

3.2.0 1-6Q2SLD Used an asynchronous call for the XML Mapping Utility to 
keep the browser from locking up if the WSDL was 
unavailable. 

Provided a Cancel button so the user could cancel if the call 
was taking too long. 

3.1.1 1-6Y3BDR Mapping Rule Migration - The CXF Rule conversion utility 
didn’t automatically set Restriction = Nillable for 
empty nodes present in 3.0 CXF Rules.

3.1.1 1-6XY6RN When selecting a SOAP Fault node in the mapper, an 
unnecessary error message was sent to the General Interface 
Builder log.

3.1.1 1-6XY6Q4 3.0 Rules with POST and empty message threw errors.

3.1.1 1-6XY6MN XML documents remained in the IDE cache after rules 
creation and update, and then the XML Mapping Utility was 
closed. 

These XML documents accumulated each time the XML 
Mapping Utility was used and closed, taking up resources.

3.1.0 1-63NS8X The SOAP Mapping Utility (now renamed XML Mapping 
Utility) could lose the association to the rule being edited. 
When this happened, the Test Rules tab stopped functioning. 

This behavior had no impact on runtime behaviors or 
performance.

Closed in 
Release

JIRA # Defect # Summary (Sheet 6 of 6)

Closed in 
Release

JIRA # Defect # Summary (Sheet 1 of 2)

3.5.1 GI-246 1-8H2F7Z The page “jsx3.gui.window.html” will now open from the 
path “GI_HOME” instead of from the launch URL.
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Documentation

3.5.0 GI-183 1-8CC7O3 Deploying the same application multiple times to the same 
page was broken with a properties bundle.

3.5.0 GI-151  1-85IPVC The Deployment Utility generated a script tag type 
attribute without an equals sign (=):

<script type"text/javascript" ...>

3.4.1 GI-111 1-86NZG3 Multiple General Interface applications deployed in a web 
page wouldn’t run and reported this error to the console:
uncaught exception:class.nsm 
jsx3.util.Logger.Record#getLevel()

3.2.0 1-772SE3 Select and Datepicker Heavyweight window were not 
anchored to the correct position when placed inside a 
dialog and deployed inside a portal page.

Closed in 
Release

JIRA # Defect # Summary (Sheet 2 of 2)

Closed in 
Release

JIRA # Defect # Summary (Sheet 1 of 3)

3.9.2 GI-986 In the API documentation, Box.addChildProfile() 
does not return an HTML string.

3.9.2 GI-978 Properly document deprecated XML DOM methods.

3.9.1 GI-859 jsxmininclusive and jsxmaxinclusive XSL parameter for 
jsx3.gui.Table are not documented in XSL reference guide.

3.9.1 GI-940 API Doc for jsx3.gui.Menu#enableItem misstates modified 
attribute name as "jsxselected".

3.9.1 GI-857 jsx3.amp.PlugIn.loadRsrcComponent document misstates 
return type.

3.9.1 GI-866 Developer Guide missing "$" on $Y examples.

3.9 GI-688 The Properties/Events/XSL API docs show the incorrect 
package in the left column.
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3.9 GI-836 In the General Interface Developer Guide, Chapter 20, 
"Asynchronous Modular Platform/Application Techniques 
and Utilities," the function definition name and the called 
function name must match. The example shows 
objJSX.onBtnClick but the called function is defined 
with an underscore after the period in <events 
jsxexecute="this._onBtnClick()"/>. 

3.9 GI-810 The example in General Interface Developer Guide, Chapter 
20, "Asynchronous Modular Platform/Application 
Techniques and Utilities," has a space in the JavaScript that 
should be removed for the sample to work correctly.

3.9 GI-809 The example in General Interface Developer Guide, Chapter 
20, "Asynchronous Modular Platform/Applications and 
Built-in Extension Points," contains a closing tag that does 
not match the opening tag. 

3.9 GI-768 Incorrect return type for CDF. getRecordIds() .

3.9 GI-721 The inlinebox tag is not defined in documentation.

3.8.0 GI-410 Update API documentation to indicate that 
jsx3.gui.TextBox.doValidate is implemented with 
String.search(RegExp).

3.7.0 GI-405 1-9L8AIR The tooltip of a block containing line feeds is displayed 
with its line feeds in Internet Explorer 7, but without them 
in Firefox 3. 

3.7.0 GI-454 1-9KW3RE Calling getAttribute() on objects of subclasses of 
jsx3.gui.Painted returns undefined if the attribute does 
not exist.

3.7.0 GI-401 1-9KZWFP API documentation for jsx3.gui.Dialog indicates that 
beep() returns void, but it actually returns the dialog 
instance. 

3.6.0 1-8F1XK0 The Migration Guide indicated that migration to GI 3.4 is 
an intermediate step in migrating to GI 3.5. 

3.4.1 GI-109 1-86Q47N See Also links in HTML version of API documentation 
were broken.

Closed in 
Release

JIRA # Defect # Summary (Sheet 2 of 3)
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Dojo Integration

Firefox

3.4.0 1-7SPC40 When running in XHTML mode, API help threw an 
exception if the inline comments in the API documentation 
weren’t XHTML-compliant. For example, API help for 
jsx3.app.Server getEnv() triggered an exception.

3.4.0 1-7Z3209 The Matrix.Column documentation was missing from API 
help (Help > API Documentation). 

3.3.0 1-7TIWOV The API documentation incorrectly stated that the Matrix 
getSortPath() and setSortPath() methods required 
the name of the attribute to be preceded by an @ symbol. 
The @ symbol wasn’t required and would break the sort if it 
was used. 

Closed in 
Release

JIRA # Defect # Summary (Sheet 3 of 3)

Closed in 
Release

JIRA # Defect # Summary

3.9.1 GI-846 Update bundled Dojo to version 1.4.1.

Closed in 
Release

JIRA # Defect # Summary (Sheet 1 of 4)

3.9.2 GI-972 Exception on call to 
netscape.security.PrivilegeManager.enabl
ePrivilege.

3.9.1 GI-483 Service call result in uncaught exception when 
server or network is unavialable on Firefox.

3.7.1 GI-493 Firefox leaks memory when jsx3.gui.Window is 
repeatedly opened and closed. An event 
subscription is not released when the window is 
closed.

3.7.1 GI-480 In Firefox, JavaScript errors are not shown in the 
system log.
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3.7.0 1-8NH7C3 In Firefox, the project link in the lower left of the 
window is truncated when clicked. This is a Firefox 
shrink effect and not a General Interface issue.

3.6.1 1-95476P When General Interface Builder was opened for the 
first time in Firefox, it prompted you to choose a 
workspace directory. To select a directory other than 
the default workspace directory, you clicked the 
open dir/file icon. The file browser did not contain 
the directory name list to choose a workspace from. 

3.6.1 1-8WAPIA In Firefox 3 the matrix column resizing was not 
working properly. Only the first row was resized 
while the remaining rows did not move.

3.6.1 1-8UHY8B A browser alert was thrown for Class Redefinition 
Exception on Firefox 3 beta 3 while asynchronous 
components were loaded.

3.6.0 1-8XPDTY Vertical scrollbars in multiselect components appear 
disabled until some other component is selected or 
after clicking on appcanvas.xml. 

3.6.0 1-8UQW9V When the last tab has a long label and the width is 
not specified, the text exceeds the tab's right 
boundary, and the tab does not display correctly. 

3.6.0 1-90RT3N Displaying WSDL Source did not work with XML 
Mapping Utility using Firefox.

3.5.1 GI-233 1-8EW151 The Matrix control now displays correctly when the 
URL points to “jsx:/xml/sample.xml” and the 
“XML Asynch” property is set to “Asynchronous”.

Closed in 
Release

JIRA # Defect # Summary (Sheet 2 of 4)
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3.5.1 GI-92 1-834QRK On Firefox, when a Matrix is scrolled to a position 
greater than zero and it (or one of its ancestor 
containers) has its display property set to none , the 
matrix scrollbar position will reset to the top (zero) 
position. This causes the Matrix scrollbar position to 
be out of synch with the top/left position of the 
Matrix data rows. 

This bug is exposed when a Matrix is contained by a 
Dialog or TabbedPane, as these both set the CSS 
display to ‘none’ when hiding their content.

3.5.0 1-8EEELZ The Matrix Datepicker column didn’t open the 
calendar when the calendar icon was clicked. 

3.5.0 GI-140 1-85LLJ7 In Firefox XHTML mode, entering an ’&’ or ’<’ 
character in a Matrix textbox edit mask could cause 
error on repaint.

3.5.0 1-7U5AWK Firefox crashed after editing the Event property for 
the Matrix Select event.

3.4.1 GI-112 1-86NFYI When the jsx_logger_config attribute was added 
to the script element on the application launch page 
and the application was run in Firefox, the 
jsx3.net.Request class sent useless security 
messages to the logger:
14:17:02.605 jsx3.net.Request (ERROR) - Error requesting Netscape 
privilege: A script from &quot;http://localhost&quot; was denied 
UniversalBrowserRead privileges.

3.4.1 GI-89 1-82IIVT General Interface didn’t support the use of 
document.domain for applications running under 
Firefox. This was due to Mozilla bug 326337 
“XMLHttpRequest.responseXML permission 
denied if document.domain set.”

When document.domain was called in Firefox, 
XMLDocument object returned by XMLHttpRequest 
or document.implementation.createDocument 
threw permission denied exceptions when any of its 
attributes and methods were accessed. 

Closed in 
Release

JIRA # Defect # Summary (Sheet 3 of 4)
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3.4.0 GI-42 1-7ZPCAF In Firefox 2 and 1.5, a long text string (wider than 
column width) in a select and select-combo mask 
column could run outside the drop-down box and 
onto the next column. If it was the last column of the 
matrix in a dialog, the long text could also run over 
the vertical scroll bar and out of the dialog. 

3.4.0 1-7YR53C In Firefox, the select-combo component was 
truncated to a width of 113 pixels regardless of the 
Width property setting.

3.4.0 1-7Y9ZKQ In Firefox, if you right-clicked the Size Array field of 
a layout component in the Properties Editor palette 
and selected a custom-created dynamic property, 
This error was displayed in the System Log:

11:38:18.484 global (INFO) - (IDPR02) error evaluating expression 
'objJSX.setDimensionArray(vntValue?vntValue.split(/\s*[,;]\s*/):[],true);': 
undefined
at jsx3.ide#BJ()
at jsx3.ide#p9()
at jsx3#eval()
at jsx3.lang.Object.eval()
... 

3.2.0 1-77QPS3 When accessing data across multiple domains on 
Firefox 1.5.x in Windows and Mac, an exception was 
thrown. For example, this occurred when running 
the WSDL_Mapping_2 sample application. 

For Firefox, you must configure proxy 
communications. See Configuring Proxy 
Communications in the Tips & Techniques 
document, Accessing Data Across Subdomains, at 
http://www.generalinterface.org.

3.2.0 1-7AP5XP Moving the mouse over a context menu in Firefox 
may cause an error message in the System Log 
palette. This message can be ignored.

Closed in 
Release

JIRA # Defect # Summary (Sheet 4 of 4)
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Internet Explorer

Closed in 
Release

JIRA # Defect # Summary (Sheet 1 of 2)

3.9.2 GI-982 Access is denied when trying to open new 
jsx3.gui window.

3.9.2 GI-977  jsx3.gui.NativeForm can go into an infinite loop 
trying to check an iframe.document with 
"Permission denied" on IE.

3.9.2 GI-974 IE10 display quirks.

3.9.2 GI-973 In IE the checkbox <label> element covers the 
checkbox input element, causing it to be somewhat 
"unclickable."

3.9.1 GI-895 Text box email validation fails if the domain name 
has a '-' in the name.

3.9.1 GI-885 NativeSelect renders nested records twice.

3.9.1 GI-876 NativeForm.setTarget() throws error in IE.

3.9.1 GI-564 Dojo Rich Text Editor is broken in Internet Explorer.

3.7.0  1-9KWA9E In Internet Explorer, the Text Area Column input box 
text is not selectable when the Matrix row selection 
is enabled.

3.7.0  GI-442 1-9GT97L On Internet Explorer, there are large gaps in menu 
item text.
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General Interface Builder

3.6.0 1-8JOK9M In Internet Explorer 7 in XHTML mode, the spyglass 
was too large for the properties editor, event 
properties, and for ctrl+alt+shift+j. 

3.6.0 1-8CK41L In Internet Explorer 6 and Internet Explorer 7, 
opening the System Log in a separate window and 
then changing the docking option to bottom or 
floating triggers multiple blank pages. This seems to 
be an incompatibility with Internet Explorer 
Developer Toolbar. 

3.5.0 1-8EAMO3 Internet Explorer 6 XHTML mode didn’t display an 
image in the Matrix Image Button column.

Closed in 
Release

JIRA # Defect # Summary (Sheet 2 of 2)

Closed in 
Release

JIRA # Defect # Summary (Sheet 1 of 11)

3.9.2 GI-999 Exception is generated in the system log on IE when a 
menu item triggers a new page to be loaded in a new 
window.

3.9.2 GI-997 System log shows 'Unable to get property 
"createRange" of undefined or null reference' when 
pressing the keyboard's left or right arrow button in 
any value of the Event Editor on IE11.

3.9.2 GI-992 ActiveX detection logic using 
(window.ActiveXObject) fails on IE11.

3.9.2 GI-991 IE11 cannot create or locate a workspace.

3.9.2 GI-983 IE10 code editor misaligned text.

3.9.1 GI-930 Builder IDE Dynamic properties editor throws NPE on 
the first property added using the [+] button on first 
column.
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3.9.1 GI-851 Attributes editor should allow dash (-) in attribute 
name.

3.9.1 GI-840 If a component is dropped on textarea, builder throws 
uncaught exception.

3.9.1 GI-835 Selecting a CDFSchema in the Builder DOM throws 
error when attributes palette is open.

3.9.1 GI-833 Select cdf Schema in dom and click toggle focus 
rectangle. Builder throws exception.

3.9.1 GI-808 jsx3.util.Logger#trace method does not supported in 
IE8 developer tools.

3.9 GI-815 Use of left and right cursor keys causes a loss of focus 
when trying the edit a property value in Builder.

3.9 GI-752 Remove the unused jsxexecute event code from 
CheckBox.xml prototype.

3.9 GI-749 Can not search API Documentation in dialog.

3.9 GI-746 In IE, a component file is authored so that the text in 
onAfterDeserialize and other metadata elements is 
wrapped in a CDATA block. This is much easier to read 
when coding by hand then escaped text.

Firefox, because of a limitation in its XSL processor has 
always serialized the component file without the CDATA 
block. The Firefox behavior should be changed to 
match IE.

3.9 GI-725 Revert does not correctly revert the component profile 
form.

3.9 GI-724 In the JavaScript Test Utility, saved history is different 
with the last pop-up menu.

3.9 GI-715 Mixed case attributes on launch script element for 
JSX30.js are not preserved as GI environment 
parameters in IE.

Closed in 
Release

JIRA # Defect # Summary (Sheet 2 of 11)
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3.9 GI-694 Selecting an item deep in Component Hierarchy palette 
causes the scroll position to jump to the top position. 

3.9 GI-692 Attributes editor should allow colon (:) in attribute 
name.

3.9 GI-677 IDE Hot Keys panel shows unresolved dynamic 
properties in Menu column.

3.9 GI-686 jsxdisabledcolor and jsxdisabledbgcolor are 
not editable from the Properties Editor palette in the 
Form GUI.

3.9 GI-630 If no project is loaded in General Interface Builder, a 
closed palette may not be revealed when it is reopened.

3.8.1 GI-696 1-9K0H1G On Internet Explorer, the Find and Replace buttons do 
not work in General Interface Builder. 

3.8.0 GI-706 plugin_auto does not work in obfuscated build.

3.8.0 GI-542 1-9SSS21 The Project Settings menu item in the lower left context 
menu opens the deployment utility instead of the 
Project Settings dialog.

3.8.0 GI-548 The Builder settings file builder.xml saved on 
Internet Explorer contains UTF-8 BOM information. 
However, GI Builder could not read builder.xml if it 
has the UTF-8 BOM.

3.8.0 GI-617 The legacy autoload setting in config.xml is not 
honored in Builder.

3.7.1 GI-506 1-9N1F17 General Interface syntax highlighting code editor fails 
in IE HTA mode.

3.7.1 GI-503 Toggling “Show Deprecated Members and Classes” 
hides all API document content.

3.7.1 GI-501 1-9MIRFP When a cache is viewed in markup view using the 
palette Read Only view button, an alert window 
indicates an error. However, you can enter Markup 
view by switching from Edit view to Markup view 
using the canvas tab.

Closed in 
Release

JIRA # Defect # Summary (Sheet 3 of 11)
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3.7.1 GI-492 Some properties of ChartLabel and Legend generate 
errors when edited in Builder.

3.7.1 GI-489 When a file is selected, the URL format is incorrect in 
XSL Merge Tool.

3.7.1 GI-488 1-9MIRG8 The context sensitive help ALT+F1 is broken. When 
clicked, it displays “Documentation not installed error 
window.”

3.7.1 GI-484 When a matrix component has a URL configuration 
that creates an error, the Event Palette view is not 
updated.

3.7.0 GI-441 1-9GP6OV An error is reported when the API Doc class is selected 
(compiled packages only). 

3.7.0 GI-453 1-9KZWGH Closing a component editor tab causes Builder to crash 
if XSL Parameters palette is loaded.

3.7.0  GI-176 1-7THZYB The GUI Components node in the Project files palette 
should be hierarchical and reflect the structure defined 
on the file system.

3.7.0 GI-376 1-9KZWHK Need to be able to open a project at an arbitrary path.

3.6.2 1-9DL60U Update URL from power.tibco.com to 
www.tibcommunity.com. 

3.6.1 1-95P54S The XSL Merge tool did not display all available cached 
XML in the Cache Select. 

3.6.1 1-8UHY7S Could not run General Interface Builder with Firefox 3; 
unable to open or create a workspace. 

3.6.0 1-8HLQR2 Some loading and initialization messages were not 
properly localized in certain locales.

3.6.0 1-8YG841 The tooltip for the DatePicker component incorrectly 
gave the dynamic property type as jsxformat. The 
tooltip now correctly describes the dynamic property 
type as jsxdateformat. 

Closed in 
Release

JIRA # Defect # Summary (Sheet 4 of 11)
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3.6.0 1-8KVW8R The maximize/restore down button on the Dialog 
caption bar did not display the correct graphic for the 
restore-down button.

3.6.0 1-8HBSSG Some loading and initialization messages were not 
properly localized in certain locales.

3.6.0 1-8JHQCJ Resizing the splitter that contained the Properties 
Editor palette did not collapse the drop down list of 
options associated with the active edit mask

3.6.0 1-8ORYFN The view of elements such as DatePicker, TimePicker, 
Select, and Select-Combo did not get updated 
immediately. The behavior has been fixed for select, 
combo, timepicker, and datepicker. Setting color and 
background-color is now applied to the correct portions 
of the control. 

3.6.0 1-90M2YJ The text align property did not work on Button and 
WindowBar until Save and Reload or similar event that 
would reset the Box profile for the object.

3.5.1 GI-231 1-8FHHIL In Internet Explorer 7 and TIBCO General Interface 3.5 
some key actions would show an error “Uncaught 
Exception: Access is denied.” in the System Log. 

These errors are no longer shown.

3.5.1 GI-232 1-8F4WHZ Scrolling logic.js no longer causes the state to be set to 
modified.

3.5.1 GI-253 1-8F1YRL Characters are now properly not escaped in the log 
files.

3.5.1 GI-235 1-8EXSXR It is now possible to test context sensitive help in your 
application while working in TIBCO General Interface 
Builder, without the TIBCO General Interface Builder 
help function getting in the way.

3.5.1 GI-259 1-8EVMV0 The Welcome Screen will not be re-displayed when a 
project is opened from within TIBCO General Interface 
Builder.

Closed in 
Release

JIRA # Defect # Summary (Sheet 5 of 11)
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3.5.1 1-8DSUP1 Installing a new version of TIBCO General Interface 
now causes the Welcome Screen to appear, even if the 
SHOW AT STARTUP checkbox has been previously 
cleared. 

To prevent the Welcome Screen from being 
subsequently displayed, clear the checkbox again.

3.5.1 GI-240 1-8DRZIU TIBCO General Interface will now provide a warning 
when the command Check For Updates fails due to a 
connection fault. The progress indicator will not be 
available. 

3.5.1 1-8D9X37 Deleting a DOM node with the TIBCO General 
Interface Builder Property Palette open will now delete 
the edit mask.

3.5.0 GI-173 1-89QBR5 In General Interface Builder, changing the Type 
property of the Select control does not cause an 
exception.

3.5.0 GI-185 1-8BWWXP In General Interface Builder, entering an invalid 
attribute name (for example, @jsxtext) in the Properties 
Editor palette for a Matrix Column, threw a Null 
Pointer Exception. The Properties Editor palette now 
stops incorrect names from being entered.

3.5.0 1-8C0B2D When using the Find and Replace dialog, only the first 
search string was found. Clicking the Find button again 
didn’t locate the next occurrence of the search string.

3.5.0 1-8AVRSL In Internet Explorer, an IFrame that showed a Windows 
Explorer browser (file:/// URI + directory path) 
showed in front of all other General Interface controls. 
If a modal dialog was completely blocked by the 
IFrame, then General Interface Builder could be 
irrevocably locked up.

Closed in 
Release

JIRA # Defect # Summary (Sheet 6 of 11)
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3.5.0 GI-179 1-7HWJMF When running General Interface Builder in Internet 
Explorer, these steps caused an exception:

1. The browser does not occupy the entire screen.

2. The Properties Editor palette is docked on the right 
side.

3. A property in the Properties Editor palette is being 
edited that uses a textbox mask.

4. The developer selects the text and continues the 
selection off the right edge of the browser.

5. The developer releases the mouse off the right edge 
of the browser.

3.5.0 GI-172 1-89MTML Couldn’t change the API search function to "class" in 
the API Documentation.

3.5.0 GI-171 1-8BSRTN Matrix metadata in the Events Editor palette was 
missing Drag and Before Drop events.

3.5.0 GI-164 1-88XY67 Clicking the Cancel button when switching projects 
threw an error. 

3.5.0 GI-163 1-88Q9V4 The Properties Editor palette for jsx3.gui.Select 
was missing a field to set the default text 
(setDefaultText:jsxdefaulttext).

3.5.0 GI-162 1-86TY0J File was corrupted by General Interface Builder when 
saved with non-ASCII characters entered in text area.

3.5.0 GI-28 1-808KFD The JavaScript editor and GUI Component Source XML 
(Expert) view line position didn’t get restored to the 
previous line scrolled down to after going to other 
views (pane) and back. The line number bar showed 
your last position in this view, but the body of the view 
was at the top of the document.

This defect is fixed for Internet Explorer, but not for 
Firefox because of this defect - 
https://bugzilla.mozilla.org/show_bug.cgi?id=241033.

Closed in 
Release

JIRA # Defect # Summary (Sheet 7 of 11)
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3.5.0 1-8CNHMC When a document in the Local Data Cache palette was 
edited and then saved (Save to Cache), if that document 
was used as the source XML for a given control in the 
user interface (such as a jsx3.gui.Tree instance), the 
saved document wouldn’t be saved to the correct cache 
and if the tree was repainted, the edits wouldn’t be 
seen.

3.4.1 GI-114 1-852ZE9 Loading a component programmatically in General 
Interface Builder cleared the state of the Component 
Hierarchy palette.

3.4.1 GI-113 1-86GCR7 When changing the name of a DOM node in the 
Properties Editor palette, the Component Hierarchy 
palette lost its value and the Properties Editor palette 
cleared.

3.4.0 1-7YL8GT In the Properties Editor palette, when you selected a 
property value from a drop-down menu, the same 
selection displayed for other properties with 
drop-down menus. 

3.4.0 GI-34 1-7ZEQH0 The objEVENT context parameter in spyglass model 
events didn’t have event information (<empty>).

3.4.0 GI-30 1-7ZW345 Although the Focus Rectangle was enabled in the 
Component Hierarchy palette, absolutely-positioned 
WindowBar instances couldn’t be moved in the work 
area of the IDE.

3.4.0 GI-14 1-7WM1VJ External files, such as xml, xsl, and jss documents, that 
were set to auto-load=true weren’t loaded into the 
application cache.

3.3.0 1-7WP11F "Reset/Clear" in the Matrix.Column Format Handler 
property caused this exception:

15:36:35.564 global (INFO) - (IDPR02)errorevaluating expression 
'objJSX.setFormatHandler(vntValue);objJSX.repaint();': 'null' is null or not an 
object
    at jsx3.ide#BJ()
    at jsx3.ide#p9()

Closed in 
Release

JIRA # Defect # Summary (Sheet 8 of 11)
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3.3.0 1-7WOXL9 When the children for a LayoutGrid were rearranged in 
General Interface Builder, the child blocks were not 
resized accordingly.

3.3.0 1-7UM83F Add-in component icons weren’t displayed correctly in 
the Component Libraries palette, because 
GI_Builder/ was prepended to the icon URI.

3.2.0 1-6BYOQP jsx3.ide.debug() statements at runtime (or Project > 
Run) throw a JavaScript error in the browser. This is 
expected behavior. To prevent these errors, wrap debug 
statements in an if statement, which refers to a global 
isDebug variable. Then set the variable to True for 
development and False for deployment.

3.2.0 1-7A5UB3 The cursor was missing in the General Interface Builder 
editor when running in Firefox. 

3.2.0 1-7CHI0R When adding a new class path on the Classpath panel 
of the Project Settings dialog (Project Settings > 
Classpath), an error was thrown and the new record 
didn’t immediately display. 

3.2.0 1-78QAO1 Unable to delete text area/textbox once it was dropped 
in the General Interface Builder work area toolbar 
(bottom of work area).

3.2.0 1-76FWL5 When switching projects in General Interface Builder 
after an exception, General Interface Builder appeared 
to be unresponsive. High CPU usage was observed 
(99%). 

3.2.0 1-72UPUR The method, jsx3.net.Service 
getEndpointURL(), appeared in API help but not 
when using the type-ahead feature (Ctrl+spacebar). 

3.2.0 1-7AOYPQ Restoring a Matrix Column from the Recycle Bin 
caused an exception.

Closed in 
Release

JIRA # Defect # Summary (Sheet 9 of 11)
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3.2.0 1-6FEKS8 Certain sequences of author-time events, including 
toggling an object's properties between Absolute and 
Relative, could cause strange results later when trying 
to move the object by dragging the object's center point. 
The object appeared in a different location than where it 
was dropped.

3.2.0 1-6U3XMU jsx3.GO() and other methods in getting a handle to an 
object which do not include the namespace found 
objects which have been placed in the trash can. This 
made updates to the view at author time unpredictable.

3.2.0 1-6X6AG4 When the Source XML (Expert) view of a GUI 
Component (2nd button on the bottom of the work 
area) was active, only the Project Files palette and the 
Local Data Cache palette should be enabled. Because 
other areas of the user interface were enabled, it was 
possible to make changes to the component using the 
Component Hierarchy palette or Properties Editor 
palette, and so on, which were not persisted. 

3.2.0 1-6X6AIS There was no warning given when a developer tries to 
import a Referenced or Referenced-async GUI 
component as a child of JSXBODY (the topmost node in 
the Component Hierarchy). All referenced components 
needed to be a child of an object in the component 
hierarchy of the referencing component. Otherwise, 
when the referencing component was saved, the 
reference was lost.

3.1.1 1-70Q8JU The Properties Editor palette got out of alignment when 
the Enter key was used for navigation.

3.1.1 1-6Z6WKR XML markup text didn’t render in the logger.

3.1.1 1-6Z6C5E jsx3.app.Monitor didn’t escape HTML/XML 
markup text.

3.1.1 1-6ZS55H Changing the Show Deprecated Classes option 
collapsed the tree, unselected the current class, and 
prevented the selection of methods.

Closed in 
Release

JIRA # Defect # Summary (Sheet 10 of 11)
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3.1.1 1-6X6LLE Pressing the Enter key while in the Type column of the 
Dynamic Properties Editor (or combo box column in 
any Grid) moved the focus two rows down. 

Closed in 
Release

JIRA # Defect # Summary (Sheet 11 of 11)

Closed in 
Release

JIRA # Defect # Summary (Sheet 1 of 10)

3.9.2 GI-987 jsx3.util.Logger implementation of console log 
handler does not work properly on Chrome.

3.9.2 GI-981 jsx3.lang.Method - getParameterNames() returns 
abstract method's last argument with /**/ empty 
comment on Chrome

3.9.2 GI-980 NativeError - cannot get line number and filename on 
Chrome and IE 10.

3.9.2 GI-976 jsx3.net.Form can go into infinite loop trying to check 
iframe.document with "Permission denied" on IE.

3.9.2 GI-956 jsx3.net.URI does not support IPv6 hosts.

3.9.1 GI-951 jsx3.net.Service getInboundDocument fails to 
return the fault XML document on SOAP fault 500.

3.9.1 GI-922 NPE in Object.getRelativePosition() in Chrome/Safari.

3.9.1 GI-921 IE phantom resize event cause GITAK commands to 
collapse Heavyweight window when it's not supposed to.

3.9.1 GI-920 Matrix Number Column shows 0.0 for an integer with "0" 
for value.

3.9.1 GI-909 Redundant code in Entity.replaceNode.

3.9.1 GI-903 Compatibility with OpenSocial gadget hosted by Shindig.

3.9.1 GI-882 NumberFormat should treat all whitespace equally when 
parsing numbers.
TIBCO General Interface Release Notes
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3.9.1 GI-879 NumberInput with bad format set causes NPE when 
parsing or formatting value.

3.9.1 GI-877 Event.getWheelDelta() does not return exactly 0 when 
there's no scrolling movement, it is also undocumented.

3.9.1 GI-862 Disable image preloading for system image files.

3.9.1 GI-841 Update URL to system requirements so that the GI version 
number is automatically part of the URL.

3.9.1 GI-906 Memory not reclaimed when removing portions of 
component files from the DOM.

3.9 GI-682 jsx3.$S() works only when deprecated methods in 
javascript.js are loaded.

3.9 GI-625 Provide the ability to abort asynchronous loads in 
Document, Cache, and Cacheable.

3.9 GI-800 Calling jsx3.eval(strScript, objContext) with 
some special parameter names such as var or function in 
objContext will cause a syntax error because in 
jsx3.eval, all parameters in objContext will be copied 
to a local variable while parameter names such as var 
cannot be used for name of local variable.

3.9 GI-735 General Interface does not load in IE8 when running in 
XHTML mode. The issue is caused by the native browser 
method HTMLElement.setAttribute. In IE8+XHTML, 
the second argument to this method must be a string, 
otherwise the value is stringified as "[object]". This 
causes no project JavaScript resources to load.

3.9 Gi-644 jsx3.gui.Select does not indicate when the data is 
loading or when there is an error with the XML data.

3.9 GI-428 jsx3.gui.Matrix: Events are not executed on active 
spyglass display.

Closed in 
Release

JIRA # Defect # Summary (Sheet 2 of 10)
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3.8.0 GI-707 The resource URL path starting with JSXAPPS/ is 
considered absolute by the General Interface path resolver 
for legacy compatibility. An application using the legacy 
resource jsx3.resolveURI("JSXAPPS/...") was 
broken.

3.8.0 GI-531 It is not possible to create a pointcut on an inherited 
method. 

3.8.0 GI-540 The dynamic property @Transparent BG resolves to -1.

3.8.0 GI-547 Localization support is required for the jsx3.gui.Table 
header CDF.

3.8.0 GI-550 jsx3.net.Form, getResponseXML, and 
getResponseText fail on Internet Explorer and Safari.

3.8.0 GI-572 Logging messages are not escaped in the application 
monitor in Internet Explorer.

3.8.0 1-9ZLRJK Add CLDR localization data for Indonesian and 
Vietnamese.

3.7.1 GI-517 Setting jsxname for a serialized object to a JavaScript 
reserved word generates an error.

3.7.1 GI-507 Add Firebug console log handler.

3.7.1 GI-500 1-9OWHCI Template resolvers that return an invalid CSS property 
(such as $bg) cause an error in IE. 

Note: The template resolver, $bg, included a trailing 
semicolon in its final CSS output. This caused a warning in 
most browsers and an error in IE. GI Builder currently 
implements two dynamic properties that return invalid 
CSS: '@Transparent BG' and '@No BG Image'. Using 
these properties will also cause an error in the template 
engine. If you are implementing a template-based class 
that needs these, create your own custom dynamic 
property.

3.7.1 GI-494 System-wide workaround is needed for Mozilla bug 
340345 in Firefox 3.0 framework.

Closed in 
Release

JIRA # Defect # Summary (Sheet 3 of 10)
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3.7.1 GI-491 Add memory statistics to benchmarking code .

3.7.1 GI-472
GI-487

1-9NK5BO 
1-9R5ZEB

URI path resolver fails to resolve components/test.xml 
to JSXAPPS/test/components/test.xml.

3.7.0 1-9ELF25 jsx3.net.Service.XML2JSON generates the wrong 
JSON string for nested nodes/objects. 

3.7.0 1-9JWAND When a menu is used as an edit mask in a matrix, the 
BeforeShow event for the menu is executed before the edit 
session can be created for the matrix. This causes the 
method emGetSession to return a null or stale edit 
session. 

3.7.0 GI-464 1-9J1VG5 jsx3.util.NumberFormat does not implement a 
internationalized version (or any version) of a parse 
method.

3.7.0 1-9J1DSP The class jsx3.gui.Window needs to provide the method 
doClose to make its APIs consistent with the functionality 
provided by jsx3.gui.Dialog. The existing method 
close only destroys the view. 

3.7.0 1-9ECYBL When autorow is set to true in a matrix with a Delete 
button column, a new row is appended. When the Delete 
button is clicked to delete the autorow, it is not deleted.

3.7.0 GI-382 1-9AUSPJ The event Destroy is not executed when the dialog 
doClose function is called to remove the dialog from the 
screen.

3.7.0 GI-403 1-9ACWIZ A tree that allows for multiple selection will have its view 
corrupted when a node is deleted.

3.7.0 GI-423 1-9KZWLD System.reloadLocalizedResources() does not reload 
add-in resources.

3.6.2 GI-416 1-9AUSR1 Select/Combo control’s getValue() method returns 
jsxtext instead of jsxid when an item is selected using a 
sequence of keyboard keys. The same method returns 
jsxid when the item is selected using the mouse. 

Closed in 
Release

JIRA # Defect # Summary (Sheet 4 of 10)
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3.6.2 1-9BGM7L The getResponseXML() method of jsx3.net.Request 
class does not return the SOAP Fault XML document. This 
issue also affects jsx3.net.Service request. 

3.6.2 GI-429 1-9CY8MB A race condition is possible in the resource loader. This can 
happen when loading multiple addins with the same 
name.

3.6.1 1-9ARWH1 Added support for Windows XP Professional, SP3. 

3.6.0 GI-305 1-8JZUUD The jsx3.util.NumberFormat.format method 
returned incorrect results when the input value started 
with "9" and contained more than four "9" digits. 

3.6.0 1-8JOC21 Projects created in previous versions had the wrong type 
set on the record with jsxid="eventsvers" in config.xml. 
The type was set to number instead of string. This caused 
migration issues when the project is opened in newer 
versions. 

3.6.0 1-8KE9JN The time format for the French locale has been updated to 
enforce exclusive use of the 24-hour time format. The 
12-hour format is not valid for that locale.

3.6.0 1-90HBLX Matrix Date and Time Column do not display localized 
data after using the setLocale() and 
reloadLocalizedResources() methods.

3.6.0 1-91CYCD An error occurs when displaying a Line LinearX chart 
using XMLURL data and XML Bind property set.

3.6.0 1-8VM95B Some formatting, such as line feeds, is lost when using the 
jsx3.net.Form.setField method.

3.6.0 1-8UZVTU Users were unable to programmatically set focus on a tab 
that was not visible in the active area of a tabbed pane. The 
doShow method has been updated to reveal the tab if it is 
scrolled out of view.

3.6.0 1-910SXP Localization files (JSS files) were not properly loaded when 
loaded as an addin.

Closed in 
Release

JIRA # Defect # Summary (Sheet 5 of 10)
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3.6.0 1-91CYCD An error was returned when setting setXMLBind to Bound 
on a linearXLineChart chart.

3.5.1 1-8JGUV7 The selection language of the MSXML 3 parser should be 
set to XPath by default to better match Firefox and MSXML 
4+ behavior. get/setSelectionLanguage should be deprecated as it 
only applies to Internet Explorer.

The previous behavior can be restored by calling 
setSelectionLanguage (“XSLPattern”) on an instance of jsx3.xml. 
Document before calling selectNodes() or selectSingleNode().

3.5.1 1-8IUDYD The  jsx3.xml.CDF method (insertRecordNode) did 
not follow the same contract as the method 
insertRecord. It would fail to perform an update when a 
CDF record was added with a jsxid that already exists in 
the CDF document. This would result in a CDF document 
containing multiple records with the same jsxid.

3.5.1 GI-192 1-8HVQVX Entering an invalid value for a component Key Binding 
would cause two problems: 

• Corrupt the component so that it will no longer load. 

• The IDE did not load any more components and would 
only display the loading message. 

3.5.1 GI-257 1-8G1CQV TimePicker.getDate() now returns correct value after 
switching AM/PM with h=12 on a 12-hour clock.

3.5.1 GI-256 1-8G0TWX TimePicker now implements getValue() correctly.

3.5.1 GI-260 1-8EMMJV TIBCO General Interface version 3.2 to 3.5 was not 
compatible with the Windows Script 5.7 for Windows XP 
update. 

TIBCO General Interface version 3.5.1 is compatible.

3.5.1 GI-251 1-8EKGFW Unescaped characters in several controls no longer cause 
errors in Firefox XHTML mode.

Closed in 
Release

JIRA # Defect # Summary (Sheet 6 of 10)
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3.5.0 1-8DWFV9 From an HTTPS URL, Internet Explorer threw this security 
alert: 

"This page contains both secure and nonsecure 
items. Do you want to display the nonsecure 
items?" 

when the user FIRST executed any of these actions:

• Clicked the [x] Delete icon of the matrix row

• Dynamically loaded (Model.load) a matrix 
component

• Clicked a select or select/combo item in the drop-down 
list (XML URL data)

• Opened or closed a dialog box containing an 
asynchronous-referenced matrix

3.5.0 1-8D25WB jsx3.util.strEscapeHTML wasn’t XHTML-compliant.

3.5.0 GI-184 1-8CDBQA Logger handlers could be added more than once to a 
handler, causing duplicate logging messages.

3.5.0 GI-170 1-8BEFIZ The Server.loadAppWindow() method threw the wrong 
kind of error when the root component wasn’t a 
jsx3.gui.Window.

3.4.1 GI-132 1-88QWW3 Attempting to load a non-existent XML document in Static 
mode caused a corrupted cache. 

3.4.1 GI-125 1-88C9J0 The jsx3.net.URIResolver.USER.getUriPrefix() 
method returned JavaScript code instead of a path.

3.4.0 1-7Z3211 When a General Interface application was deployed to an 
HTTP server and the launch page for the application 
wasn't a sibling to the JSX directory, these default system 
images were not resolved correctly:

• The plus/minus toggling icon for tree and matrix-tree 

• The transparent image used for all CDF controls 

• The green check mark icon used for the select options 
list to denote which option is selected

Closed in 
Release

JIRA # Defect # Summary (Sheet 7 of 10)
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3.3.0 1-7ZP9SH / 
1-7YTIK0 

In some versions of Internet Explorer 6 and 7, XML, XSL, 
and JSS files were never cached by the browser. TIBCO 
General Interface has been modified to work around this 
issue. 

For more information on Internet Explorer caching and 
best practices, see “Understanding Internet Explorer 
Caching” at http://www.generalinterface.org in the Tips 
and Techniques section.

3.3.0 1-7XUQPP The jsx3.xml.Processor constructor didn’t accept  
jsx3.xml.Entity (and subclass jsx3.xml.Document) 
for the source document parameter.

3.3.0 1-7Y9EB1 The jsx3.net.Form() method caused an error due to 
obfuscation.

3.3.0 1-7U7YT1 The activateOnHotKey attribute of the application 
monitor (logger.xml) doesn’t work. It should disable 
the application monitor until the hot key, Ctrl+Alt+m, is 
pressed in the application.

3.3.0 1-7WUUZU The jsx3.resolveURI() method erroneously removed 
query parameters and fragment parts of the URI.

3.3.0 1-7VUMGR In Internet Explorer and over HTTP, if a component file 
contained a dynamically loaded class and an include that 
referenced another component file that also contained the 
same dynamically loaded class, General Interface under 
certain conditions showed FATAL alerts about trying to 
reload the class.

3.3.0 1-7V4G99 The jsx3.xml.Entity.setValue() method caused 
inconsistent behavior in the XML Mapping Utility. In 
Firefox, this method was concatenating the string by 
appending each new bit of text, while in Internet Explorer 
it was replacing any existing text. 

The correct behavior was to replace all content of the entity 
with the text value of the input parameter, so that the only 
value of the entity is the newly added text value. Firefox 
and Internet Explorer now consistently handle these 
methods: setValue(), createNode(), 
insertBefore(), and appendChild().

Closed in 
Release

JIRA # Defect # Summary (Sheet 8 of 10)
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3.3.0 1-7V4G9S A Tabbed Pane container with two asynchronously loaded 
Matrix components (asynch referenced the same matrix) 
that were set with the Not Selectable property caused an 
exception: 18:02:38.747 global (ERROR) - 
Uncaught Exception: Reference to undeclared 
namespace prefix: 'xsl'.

3.2.0 1-7CIEMN In General Interface Framework, there was a problem if 
you used an edit mask within a Matrix and that given 
Matrix instance didn’t use any pagination 
(jsx3.gui.Matrix.PAGING_OFF). 

Calling the redrawRecord() method or any method that 
calls redrawRecord(), such as insertRecord() or 
insertRecordNode(), resulted in an error. 

3.2.0 1-79I48Z The Dynamic Properties editor (Matrix control) threw an 
exception when updating the jsxid column and required 
refresh to be in synch with underlying data.

3.2.0 1-73QTJ7 Removing a child of a layout grid (and its subclasses such 
as StackGroup) didn’t properly remove the child HTML. 

This was true if the layout grid had been repainted but not 
true if the children had been added with insertHTML(). 

3.2.0 1-72KUMP Hot keys registered as properties of the button classes or 
registered as the jsxkeycode CDF attribute of menu should 
register themselves with the first ancestor DOM node that 
was a jsx3.gui.Window, jsx3.gui.Dialog, or root 
block of a server. 

3.2.0 1-72G8V7 CDF records with only numeric IDs cause ID collisions. 

3.2.0 1-70Q86W Added missing getServer() method to the 
jsx3.net.Service class, allowing for more consistent 
experience in both General Interface Builder and runtime.

3.2.0 1-712JG1 It wasn’t possible to combine nodes or documents that 
were created using differing threading models. 

The threading model used by the xmlhttp control and the 
threading model used by static XML documents were 
different. 

Closed in 
Release

JIRA # Defect # Summary (Sheet 9 of 10)
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GIPP/GITAK

GUI Components 

3.2.0 1-6X3V2V Adding more than two children to a splitter parent caused 
unpredictable runtime behavior. 

3.1.1 1-72252X jsx3.net.Service.setTimeout caused JavaScript error, 
"onTimeout is undefined". 

3.1.1 1-6XP1CC XSL document was reloaded when destroying List/Grid.

3.1.1 1-6YKVJL Date Picker failed in GMT-nn time zones.

3.1.0 1-692LVH The JavaScript function setTimeout was not supported in 
the version of the HTTP object referenced in Project 
Deployment Options.

Closed in 
Release

JIRA # Defect # Summary (Sheet 10 of 10)

Closed in 
Release

JIRA # Defect # Summary

3.9 GI-825 GITAK runtime is missing from the 3.8 distribution.

3.9 GI-708 Test recorder NPE when a model event triggers the 
removal of the event publisher from the DOM.

Closed in 
Release

JIRA # Defect # Summary (Sheet 1 of 21)

3.9.2 GI-975 jsx3.gui.Template based UI display issue on Safari 6 
and chrome.

3.9.2 GI-971 jsx3.html.getCSSOpacity() should return 
"opacity:<value>;" instead of 
"filter:alpha(opacity=<value>);".
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3.9.2 GI-967 Under Chrome, matrix header not matching column. 

3.9.2 GI-864 Matrix - Hierarchical: nodes in the same level don't aligned 
vertically when some of them are wider than the container.

3.9.1 GI-952 Disabled toolbar button does not show the button icon as 
grayed out.

3.9.1 GI-937 Matrix DatePicker formatter is broken when there is a 
conflict between data store format and display format.

3.9.1 GI-913 NPE occurs when paged matrix control is repainted or 
accessed while off screen.

3.9.1 GI-910 Read-only NumberInput should not increment/decrement 
with mouse wheel.

3.9.1 GI-900 Drag-and-drop reordering of Matrix column fails on right 
most columns of a large column set.

3.9.1 GI-891 Matrix Reorder event not fired when moving a column 
into the last position.

3.9.1 GI-890 Long cell text mangles with the + / -icon. on Matrix-Tree.

3.9.1 GI-884 Combo CHANGE event may not fire when blurring the 
combo input field.

3.9.1 GI-881 Ability to disable dates and months in the DatePicker 
calendar popup.

3.9.1 GI-880 Allow the null value label of a DatePicker to be 
overridden.

3.9.1 GI-871 Change event not firing when date control is cleared.

3.9.1 GI-867 Matrix autorow cleanup results in an exception.

3.9.1 GI-935 Focus/unfocus in matrix cell with edit mask makes 
increasing number of invocations of edit mask.

3.9.1 GI-865 jsx3.gui.NativeForm Multipart property is broken.

Closed in 
Release

JIRA # Defect # Summary (Sheet 2 of 21)
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3.9.1 GI-854 Provide new methods: TextBox.getSelection and 
setSelection.

3.9.1 GI-848 NativeSelect and NativeFileUpload don't implement 
getValue() correctly.

3.9.1 GI-844 LayoutGrid.getRows(), documented return type is String, 
can return Array.

3.9.1 GI-823 Visibility:visible is not properly applied for Chrome 
browser.

3.9.1 GI-711 Combo select case insensitive comparison is not i18n ready 
or overridable.

3.9 GI-744 Implement correct border and margin properties on Tab 
and TabbedPane.

3.9 GI-709 When an object of class jsx3.gui.Select is set to 
Combo/Type ahead, it publishes a SELECT event when the 
user selects a value from the option list.

It should also publish an event if the value of the input is 
changed by entering a new value manually that does not 
match one of the options.. 

3.9 GI-695 Position of matrix edit masks is incorrect if HTML body 
with overflow property other than hidden (default is auto) 
is scrolled.

3.9 GI-661 To improve accessibility by user agents and users who 
have turned images off, alternate text is supported for all 
user-supplied images, including user configured image 
element, Image button, and Toolbar button(alt=). 

3.9 GI-656 To improve accessibility by users who have turned images 
off, alternate text is supported for the System Image, which 
includes all GI provided UI controls with image 
sub-component, such as DatePicker’s previous/next year 
and month, Spinner’s up and down buttons and Slider’s 
slide handle.

3.9 GI-767 Removing a button activated by a hot key should 
deregister the hot key.

Closed in 
Release

JIRA # Defect # Summary (Sheet 3 of 21)
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3.9 Gi-766 When a number is entered in NumberInput and the 
doValidate method is invoked, Builder throws an 
exception.

3.9 GI-745 Controls such as TabbedPane should honor the padding of 
their parent block.

3.9 GI-720 Some Matrix operations throw an error in IE when the 
matrix is rendered in another window.

3.9 GI-717 jsx3.gui.Matrix throws an exception when a column 
with a button mask has properties (such as onmousedown) 
defined with quotes.

3.9 GI-703 For jsx3.gui.Select, the Text and Options list is not 
updated correctly if set to asynchronous.

3.9 GI-676 There is a hierarchical matrix rendering glitch on Safari.

3.9 GI-687 Disabled color and background color are not applied for 
Radio buttons and check boxes on Internet Explorer.

3.9 GI-657 Cannot use Multiselect control from the keyboard 
(accessibility issue).

3.8.1 GI-407 1-9BLPU5 Stack group vertical stack container (|) displays text 
horizontally.

3.8.0 GI-284 Splitter Container 1 Min is not enforced during window 
resizing.

3.8.0 GI-426 Resized splitter sits above dialog box in Firefox 3.

3.8.0 GI-532 The xsl:attribute in the matrix column value template 
that is applied to a parent element is not reapplied during 
cell repainting.

3.8.0 GI-534 Dragging a horizontal splitter inside a tab to another tab 
breaks the splitter and content.

3.8.0 GI-543 Incorrect order sometimes results from dragging multiple 
rows of a matrix.

Closed in 
Release

JIRA # Defect # Summary (Sheet 4 of 21)
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3.8.0 GI-622 jsx3.gui.Sound does not work with Firefox and 
Quicktime.

3.7.1 1-AD8AI7 Text box change is not vetoable.

3.7.1 GI-519 The TextBox CHANGE event cannot be vetoed.

3.7.1 GI-516 When a matrix is scrolled horizontally, it does not adjust its 
left position if the ancestor container was resized to a 
larger size. There is a gap at the right edge of the matrix, 
which scrolls the rows off the screen.

3.7.1 GI-486 If objCOL.setDisplay(jsx3.gui.Block.DISPLAYNONE 
is used to hide a column in a matrix and then a column to 
the right of the hidden column is resized, an incorrect 
intCOLUMNINDEX is returned in the event handler for the 
resizing operation.

3.7.1 GI-509 1-9OVGWJ If there is a change in the underlying CDF that is preceded 
by an initial scroll in a paged matrix, repaintData() does 
not update the view.

3.7.1 GI-68 Double-clicking on the matrix column divider auto-sizes 
column width.

3.7.0 GI-292 1-9K4K1S Setting the BG color property to @Transparent BG for the 
splitter component breaks the component.

3.7.0 GI-419 1-9L39WP Stacks displaying menus in the bar (such as the palettes in 
Builder) could cause the active stack to shift unexpectedly 
when removing a stack from the stack group.

3.7.0  1-9L39TP jsx3.gui.Dialog does not show the dynamic property 
jsxtext in the Task bar tab.

3.7.0 1-9GYNBZ When a stack is dropped on any container other than 
stackgroup in Internet Explorer 7, an exception is created. 

3.7.0 GI-440 1-9GYNAT Component Hierarchy palette toolbar buttons is disabled 
after new components are added.

3.7.0  GI-272 1-9KZWMG DatePicker loses the default format when the value is 
deleted twice.

Closed in 
Release

JIRA # Defect # Summary (Sheet 5 of 21)
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3.7.0  GI-295 1-9KZWNR When jsx3.gui.Matrix is set to hierarchical rendering 
mode, the custom open/close icons on the hierarchical 
matrix do not change as they should.

3.7.0 GI-296 1-9L39TP jsx3.gui.Dialog does not show the dynamic property 
jsxtext in the taskbar tab.

3.7.0 GI-400 1-9L39UH TimePicker does not conform to the contract of 
jsx3.gui.Form; it does not implement doValidate.

3.7.0  GI-408 1-9L39VQ The browser context menu is not blocked for 
jsx3.gui.Window. In a new window created using 
server.createAppWindow, the browser context menu 
always appears. For the main window it is not shown. 

3.7.0 GI-420 1-9CAOI3 An exception occurs when the setDisplay method of the 
new component inherited from 
jsx3.gui.Template.Block is called. 

3.7.0 GI-425 1-9L39ZK A template with a <for-each> loop did not function 
properly when a resize event occurred.

3.7.0 GI-427 1-9L3A0L Add support for getValue and setValue methods to 
CheckBox and RadioButton control for CDF mapping.

3.7.0 GI-431 1-9L3A1G Add support for multi-level property (object property) in 
jsx3.gui.Template.Block.setProperty.

3.6.2 1-9C4AR9 Dialog control created using with constructor does not 
contain the maximize button in the window bar. 

3.6.1 GI-372 1-959QLY Combo control regression: getValue() returned the text 
instead of the jsxid.

3.6.1 GI-302 1-917199 Under certain conditions, dropping entries onto a Matrix 
component did not properly account for the rendering 
context. 

Note that this defect was marked closed in release 3.6.0, 
but actually is closed in release 3.6.1.

3.6.1 1-95LYL9 The time selected in timepicker differed by one hour from 
the timepicker.getDate() value called within Change event. 

Closed in 
Release
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3.6.1 1-96AM6R Table headers did not display when no data was available 
for the headers.

3.6.1 1-96YYLR Typing in a combo box with valid option text and then 
clicking the tab key did not select the valid option.

3.6.1 1-96ZW5T DatePicker did not implement the getValue() method 
required for jsx3.gui.

3.6.0 1-8VM944 Disabled form fields were able to receive focus, either by 
mouse-click or tab-key selection. You can no longer tab 
into a disabled form field, including combo and select 
boxes.

3.6.0 1-90ODVT The text editing cursor remained in the textbox after the 
focus was moved away to a button by a user click or by the 
using the tab key.

3.6.0 1-9171BN In previous releases, the method getSortedIds for Matrix 
components did not account for the rendering context, and 
therefore, the row count returned was potentially 
inaccurate. 

3.6.0 1-8VGMYM Menu hotkey does not work if the menu's CDF data is 
loaded asynchronously from a file pointed to by XMLURL.

3.6.0 1-8EBIXD Calling repaintData while the Matrix display property is 
set to "none" results in no vertical scroll bar when display is 
restored.

3.6.0 1-8NGCDO After dynamically loading a Matrix into the content pane 
belonging to a hidden Tab, the Matrix rendering 
overlapped the TabbedPane control when the Tab was 
displayed. This only occurred when the content pane's 
load type was set to "Deserialize on show".

3.6.0 1-93LEGR A Matrix with dialog mask caused an exception if there 
was a taskbar present. 

3.6.0 1-8K05W1 The combo select control triggered a Select event after the 
user typed a partial string then moused to the selection 
window.

Closed in 
Release
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3.6.0 1-936B9Q In Internet Explorer, the Matrix select/combo mask 
drop-down did not collapse while adjusting the column 
width.

3.6.0 1-8IGQBM When using the paginated paging model, the Matrix did 
not listen to the mousewheel event.

3.6.0 1-93ITQ0 Updating dialog caption text did not update the tool tip on 
the associated task bar button.

3.6.0 1-8EBIXD Calling repaintData() while matrix is display=none 
resulted in no vertical scroll bar when display is restored.

3.5.1 GI-266 1-8IUN7F In Internet Explorer with MSXML3, when a user would 
click any column header to sort by that column (n), the sort 
indicator would appear on the column to the right of the 
one that was clicked (n+1).

3.5.1 1-8IUE0E A SelectBox that referenced its data in an external file 
(setXMLURL) which also:

• was set to asynchronously load its data (setXMLAsync) 

and 

• had a default/initial value (setValue) 

would not update the UI with the resolved lookup value 
when the asynchronous data did finally arrive.

3.5.1 GI-221 1-8HYTSM An error would occur when tabbing between tabs in 
TabbedPane.

3.5.1 GI-222 1-8HYTRB The jsx3.gui.Tree component did sometimes paint 
incorrectly.

3.5.1 GI-220 1-8HVQX6 Adding a Splitter as one of the children of a LayoutGrid 
made the Splitter incorrectly display its two children. 

3.5.1 GI-237 1-8HPYKA DatePicker would leave Jan 1 1970 in the matrix when no 
value was entered.

Closed in 
Release
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3.5.1 GI-258 1-8HPYJ5 The column reordering logic used by the matrix did not 
work in these scenarios:

• No column could be moved after the last column

• The first column couldn’t be moved

• If the matrix used a horizontal scrollbar, it did not scroll 
horizontally to reveal columns that were not already 
visible at the time when the reordering event began.

3.5.1 1-8HPYI5 Resizing paged matrix to a bigger size did not move the 
visible page to the right vertical position in Internet 
Explorer; it did, however, move the page in Firefox.

3.5.1 GI-254 1-8HLQMH TextBox would always paint the default width or height, 
which prevented sizing of the text area with rows or 
columns.

3.5.1 GI-238 1-8H53YJ Dialogs will resize properly even when their height or 
width are set using a dynamic property.

3.5.1 GI-247 1-8H2F7H Incorrect behavior when clicking on jsx3.gui.Table 
data rows would not dismiss an open context menu in 
Internet Explorer has been fixed.

3.5.1 GI-252 1-8GW05L The property “Container 1 Min” now behaves correctly on 
the second attempt to move it pass the specified minimum 
size (100). 

The drag image will no longer become disembodied from 
the splitter bar.

3.5.1 GI-244 1-8GW053 Headers will now display properly in the table controls 
when placed in the 2nd, 3rd, and other tab panes.

3.5.1 GI-245 1-8GIS9I The null pointer exception caused by a jsx3.gui.Table 
configured with an external XML URL and with enabled 
XML asynchronous loading properties has been fixed.

3.5.1 GI-234 1-8EYS1Y Cascading submenus are now positioned correctly in those 
cases where the parent menu is closer to the bottom of the 
page than the top, and where the child menu is shorter 
than the distance between the top of the page and the top 
of the parent menu.

Closed in 
Release
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3.5.1 GI-158 1-8EYHHB Any paginated matrix that used Format Handlers to 
reformat the display of cell data will now only reformat a 
subset of all possible cells.

3.5.1 GI-236 1-8EL2ID Cursor property is now correctly honored by the form 
element TextBox/TextArea/Select/Combo.

3.5.1 GI-255 1-8EKGFD Text box-password Max Length property will now work 
properly in XHTML mode.

3.5.1 GI-248 1-8E7PFE Menu with no data now has an improved “No Data” 
message.

3.5.0 1-8EERV7 An exception was thrown when setting the XSL URL and 
the XSL wasn’t loaded. 

3.5.0 1-8EE4CC From HTTPS URL, Internet Explorer threw the security 
alert "This page contains both secure and 
nonsecure items. Do you want to display the 
nonsecure items?" when the user deleted a Matrix row 
(Matrix List prototype) using the delete column (Matrix 
Delete column).

3.5.0 1-8DL6UD The scroll-into-view logic used by the Matrix class was 
throwing a null pointer exceptions when a matrix was 
used as a mask by another matrix. 

3.5.0 1-8DKJ4M Scrolling a matrix with the scroll wheel didn’t collapse the 
active edit session, leading to unaligned heavyweight edit 
masks.

3.5.0 GI-128 1-8DBUDF Heavyweight components were not positioned and sized 
correctly when the deployment page (the document body) 
was scrolled. 

3.5.0 1-8D9OPE Some form controls didn’t honor the contract for cursor. 

Closed in 
Release
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3.5.0 1-8D5O4H  jsx3.gui.Block instances that implement drag 
(setCanDrag) created a drag icon that wasn’t 
cross-browser compatible, resulting in the text, 'undefined', 
following the cursor. 

This is fixed to be consistent with the other GUI controls 
that support drag-and-drop (matrix and tree). These 
provide a default method (getDragIcon) that returns 
generic markup appropriate to the control type while also 
allowing the developer to override this method on an 
instance-by-instance basis to customize the drag icon.

3.5.0 1-8CYQC9 jsx3.util.DateFormat("MMM d, 
yyyy").parse("Feb 29, 2008") yielded March 1. 

3.5.0 1-8CYCOP Select/Combo and Menu key navigation was broken. 
Menu scrolling displayed poorly.

3.5.0 1-8CRHVR The autorow for the Matrix had three specific bugs that are 
now fixed:

1. It wrongly identified deltas in the autorow, which lead 
to empty rows being added to the matrix.

2. The autorow didn’t take the rendering context into 
account and appended everything to jsxroot.

3. The autorow allowed for an empty jsxid property to be 
committed.

3.5.0 1-8CG6R6 A CSS-related bug in the Matrix class (width) caused the 
Events Editor palette in General Interface Builder to 
truncate text in the 'Value' column after saving and 
reloading a component. 

3.5.0 1-8C5VGN If a Properties Editor palette and Events Editor palette 
wasn’t expanded and was then undocked, the editor 
content didn’t display.

3.5.0 GI-159 1-8C3E4Q Character limit prevented the Change event from firing on 
a text area in some cases.

3.5.0 GI-106 1-8C3E2R Using Ctrl+click on a RadioButton or CheckBox could 
commit events and property edits to the wrong object.

Closed in 
Release
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3.5.0 GI-182 1-8C2ZTZ Load/Reload in General Interface Builder didn’t work 
with a properties bundle file.

3.5.0 GI-181 1-8BWOG5 jsx3.app.Properties caching caused the get() 
method to return a bad value after a grandparent was 
removed or added.

3.5.0 1-8BELJD In Internet Explorer, when a column in the matrix had 
right- or center-aligned content, resizing the column 
caused only the first cell to resize, leaving all other cells at 
the wrong dimension. 

3.5.0 GI-169 1-8BCION A dialog lost its border after it was moved, minimized, and 
maximized when a task bar wasn’t present.

3.5.0 GI-174 1-8AVRLY Matrix edit masks didn’t resize when their column was 
widened.

3.5.0 GI-168 1-8ASG52 A layout issue occurred with menu bar and toolbar. 

For example, when a Toolbar was the direct child of a 
Layout, the toolbar buttons didn’t display.

3.5.0 GI-180 1-895KXB The first column of an hierarchical matrix didn't honor cell 
styles. 

This caused various property settings not to be honored. 
For example, if word wrapping was set to false, the text 
would still wrap.

3.5.0 GI-161 1-86ACHX The height of the active stack content pane wasn’t updated 
when adding or removing other stacks from the same stack 
group.

3.5.0 GI-146 1-862VHR Overflow property of TextBox in General Interface Builder 
had incorrect enumerated values. OVERFLOWNORMAL, 
AUTO, and SCROLL fields in TextBox were incorrectly 
deprecated.

3.5.0 GI-141 1-859IQ7 In XHTML mode, an error was thrown when a value was 
entered in the IFrame Source URL field in the Properties 
Editor palette. 

The error was also thrown when selecting Reset/Clear 
from the context menu.

Closed in 
Release
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3.5.0 GI-139 1-855SNK When the IFrame prototype had a default value about: 
blank, you couldn’t reset the source in XHTML mode and 
an error was triggered.

3.5.0 GI-160 1-853I07 When the dialog mask column was last in a matrix grid, 
the dialog popped up off the matrix area and caused the 
matrix display to be out of alignment.

3.5.0 GI-99 1-84QDH6 In Internet Explorer 7 XHTML mode, menus weren’t 
rendered correctly. For example, submenus were detached 
and couldn’t be selected.

3.5.0 GI-93 1-834QYZ When the select/option drop-down list was long, the 
vertical scroll bar took up space within the drop-down 
window instead of getting extra width and the longer 
select text was truncated.

3.5.0 GI-58 1-7BPVY0 In a multiple-level menu, moving the mouse quickly in 
and out of a nested submenu caused the submenu to 
detach and move to the top left of the browser window. 

The problem was most apparent when the submenu was 
long or when the browser was repeatedly refreshed. 

3.4.1 GI-126 1-88QU4Z The setText() method on the Tab component didn’t 
update the parent TabbedPane scroll indicators.

3.4.1 GI-118 1-88C9HT Cacheable GUI controls with an invalid XML URL or XML 
String property threw an exception on paint.

3.4.1 GI-129 1-888L5E The Slider component listened to keyboard/wheel events 
even when the Enabled property was set to Disabled.

3.4.1 GI-119 1-87CTVM Hot key failed for Image Button.

3.4.1 GI-110 1-86Q45H The Matrix.revealRecord() method was broken for 
certain versions of Internet Explorer and MSXML.

Closed in 
Release
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3.4.1 GI-115 1-80Y4RN An exception was thrown when minutes were entered in a 
TimePicker column:
11:30:59.931 global (ERROR) - Uncaught Exception: Object doesn't support this 
property or method (line: 13, file: file://C:\tibco\gi\3.3\GI_Builder.html)
    at jsx3.gui.TimePicker.Fi()
    at anonymous(j) { return j.Fi(j.jsxshowsecs?"second":"ampm");}
    at anonymous() { if(k.getParent()==null)return;var 
xb=g.value;if(nc==xb)g.value=xb=S...
    at jsx3#vC()

3.4.0 GI-103 1-84ZLB9 The @lookup format handler didn’t resolve lookups unless 
the edit mask was a direct child of the matrix column. 
Therefore, matrix column @lookup format handler didn’t 
work with BlockMask or a DialogMask. 

3.4.0 GI-102 1-84ZL9Z Applying focus to a cell that was non-existent because it 
belonged to a paginated matrix didn’t work. If the cell 
didn’t exist, the Matrix should be scrolled to the correct 
location, so that the given page that contained the cell was 
rendered and the cell was made available for focus. 

In addition, there wasn’t a method, revealRecord(), as is 
provided by tree, meaning it wasn’t possible to display a 
given cell without first applying focus.

3.4.0 GI-101 1-84ZL8Z The setValue() method wasn’t properly implemented by 
the matrix. When passing an ID or an array of IDs if 
selection model is multi-row, the given record(s) weren’t 
selected and the first record wasn’t scrolled into view.

3.4.0 GI-100 1-84TGPY Drag-and-drop from Tree to Matrix didn’t work. Also, 
poor support for adoption of records that contained nested 
records. 

3.4.0 GI-98 1-84JSFJ In General Interface Builder, the Properties Bundle editor 
and the Dynamic Properties editor should prevent entering 
duplicate jsxids.

3.4.0 GI-97 1-843RIP Heavyweight windows, such as menu and select 
drop-down list, didn’t move with the menu anchor or 
select box when the browser window was resized. 

This was especially apparent when a block container was 
right-aligned.

Closed in 
Release
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3.4.0 GI-96 1-8434XJ Matrix with paging off should apply format handlers 
synchronously at repaint() and repaintData(). This 
will eliminate flickering in this case.

3.4.0 GI-95 1-842SW4 KEYUP event didn’t fire for combo select.

3.4.0 GI-84 1-83WMBP Form elements didn’t inherit font color from the ancestor 
block. 

3.4.0 1-834YTH Dialog when dragged didn’t have top-most Z-index, so 
that it appeared to drag behind other dialogs.

3.4.0 GI-91 1-834QR3 Setting the Tag Name property of block in General 
Interface Builder didn’t regenerate the HTML. 

3.4.0 GI-90 1-830NQL In the Properties Editor palette in General Interface 
Builder, switching the Type property from textbox to 
textarea or textarea to textbox didn’t work. 

3.4.0 GI-88 1-82I3L9 Saving an XML file in General Interface Builder with an 
XML declaration created “unsupported” comment. 

3.4.0 GI-86 1-81HOEW If a dialog with a select-combo component was moved on 
the screen, it lost its value and new values couldn't be 
assigned even though they could be selected from the 
drop-down list.

3.4.0 GI-85 1-81HAI7 The jsx3.gui.Button.focus() method didn't apply 
focus to the correct HTML DOM node and didn’t work at 
all in Firefox.

3.4.0 GI-37 1-81B3K3 The Time Picker didn’t respond to the number pad of the 
keyboard. 

3.4.0 GI-38 1-818IT6 The objEVENT was null in the CHANGE model event 
context of jsx3.gui.Slider when using the up and 
down arrow keys to edit values.

3.4.0 GI-43 1-80OOH3 When deserialized a dialog box top-left position could be 
at a negative position if the min-width and min-height 
were larger than the client window and no top-left 
positions were defined. Call constrainPosition(true) 
if there is a chance that the dialog is larger than its parent. 

Closed in 
Release
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3.4.0 1-80I857 When the No Wrap property was set for a text area, text 
was still wrapped.

3.4.0 GI-33 1-7ZOVRR Matrix didn’t conform to the contract of jsx3.gui.Form, 
because it didn’t implement doValidate. 

Note that doValidate() returns 1 if the form element is 
optional or if it's required and at least one row is selected.

3.4.0 GI-21 1-7YTKVZ The tab EXECUTE event didn’t fire when the tab was 
clicked.

3.4.0 1-7YTJ72 If a dialog that contained a Matrix Grid was moved while a 
text edit box in the grid had focus, the text box couldn't 
receive focus or be edited after it was moved. 

3.4.0 GI-22 1-7YR59D Entering text in the Text/HTML property of a block in the 
Properties Editor palette and adding a select component to 
the same block, prevented the General Interface Builder 
tabs from working and you couldn’t switch between tabs. 

3.4.0 GI-12 1-7Y9ZJR The Font Weight property for the toolbar button wasn’t 
working properly.

3.4.0 GI-16 1-7VUTFJ Select.doValidate() should be verifying against the 
selectable value (valid jsxid in the CDF) instead of 
considering all non-null value to be valid.

3.4.0 1-7KV0SU Tabs don't cascade to the next row if they exceed the 
viewable space. TabbedPane now provides an automatic 
right and left scrolling mechanism for navigating through 
tabs that are hidden when they exceed the viewable space. 
Hover over the right or left arrow icons to scroll through 
the hidden tabs. You can also navigate tabs using the right 
and left arrow keys.

3.4.0 1-7GFNGT If a drop-down menu had a vertical scroll bar, it might 
have been impossible to move the mouse to a submenu 
without hiding the submenu. In Internet Explorer, 
mousing over the scroll bar caused a mouse out event on 
the active menu item.

3.4.0 1-7DS71V The main body of the Matrix didn’t respond to the scroll 
wheel on the mouse.

Closed in 
Release
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3.4.0 GI-8 1-7C7LIW The Text field in the combo component wasn’t disabled 
when the component was flagged as "disabled."

3.4.0 GI-63 1-6THXVP Submenus and menus weren’t aware enough to always 
cascade in the most optimal direction. Long menus at the 
bottom of the screen, particularly those with long 
submenus, were rendered with scroll bars. Long menus 
now render with auto-scroll arrows instead of scroll bars.

3.3.0 1-7Y9EC9 Some formats of the 
jsx3.gui.Matrix.ColumnFormat.getInstance() 
method didn’t work. 

3.3.0 1-7XUQQU Calling the dialog.focus() method on a modal dialog 
caused the loss of modal. 

3.3.0 1-7XJ0NF Several XSLT features (particular as implemented by the 
Matrix) caused a noticeable slowdown. First, due to 
browsers not caching XSL imports, any repaint command 
on a Matrix (or the other CDF controls) forced a roundtrip 
to the server, which caused a substantial impact on even 
the smallest update. In addition, the Matrix should expose 
a public API that allows developers direct access to the 
native HTML element for a Matrix cell. This was critical 
when integrating with technologies, such as Comet, DWR, 
or Lightstreamer, where using XSLT for a simple update to 
a cell was CPU intensive.

Added a new public method to Matrix, 
getContentElement(), that allows access to the HTML 
element by providing the CDF record id and the named 
attribute on the CDF.

3.3.0 1-7X9FEW Importing failed with an exception when canvas was 
"dirty" (after adding a new container and trying to import 
into its pane).

3.3.0 1-7X3RV2 The cursor for Matrix cells in Internet Explorer appeared as 
the text cursor (cursor:text;) except in portions of 
header cells where text wasn’t present. 

Closed in 
Release
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3.3.0 1-7X3RSF In Internet Explorer, unless a row in the Matrix explicitly 
implemented a bgcolor (specified in the XSL Parameters 
Palette or the Properties Editor palette), the text bled 
through onto the next cell in the row. 

3.3.0 1-7X3APA The jsx3.gui.Button class couldn’t be toggled from 
relative to absolute and have the left/top be honored. 

3.3.0 1-7WS633 With a Matrix row selected, switching the application focus 
to another application, such as Notepad, and then 
switching back to the browser caused multiple (2) select 
events to be triggered.

3.3.0 1-7WS62L After resizing the Properties Editor palette and the Events 
Editor palette by resizing the splitter pane or resizing the 
browser window, “Reset/Clear” a property caused the 
name cell to expand in size.

3.3.0 1-7VK76Z In Internet Explorer 6, a modal dialog invoked from a 
menu in a layout pane wasn't rendered correctly. This 
occurred on initial loading of dialog and every other 
loading of dialog, such as third and fifth. On the second, 
fourth, and sixth loading of dialog, the modal dialog was 
rendered correctly.

3.3.0 1-7U5AVZ The Space key didn’t trigger select (or execute) event for a 
Matrix List or a Matrix Grid. 

3.3.0 1-7TLD4E 

and

1-7UM7XG

When a Tree was already displayed on the screen and the 
insertRecord() method was used to add the first new 
child record to a node, the new Tree node displayed was 
detached from the parent node.

3.3.0 1-7T8Y2X A Dialog could be resized to a "floating" drag corner image 
by dragging the left bottom edge of the dialog to the right 
top edge.

3.2.0 1-7RUQNG While dragging a record from a can drag Matrix control to 
another drop-enabled Matrix control, the mouse cursor is 
changed into a forbidden cursor (/).

Closed in 
Release
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3.2.0 1-7D33L9 Calling the setDisplay() method on a Matrix Column 
child should result in the XSLT for the owning Matrix to be 
reset. 

3.2.0 1-7CM78U When using a paginated instance of the Matrix 
(jsx3.gui.Matrix.PAGING_PAGED), if records were 
added and removed and the Matrix was then repainted (by 
calling repaintData() or repaint()), the scroll bars 
didn’t update to reflect the changed record count. 

3.2.0 1-7AMECV Selecting a different node in the Component Hierarchy 
palette while editing a property in the Properties Editor 
palette might have caused the change to affect the newly 
selected object, not the intended object.

3.2.0 1-79KHWA Using the Tab key in the Properties Editor palette after 
editing a value triggered an exception. The Tab key didn’t 
work in the Matrix component.

3.2.0 1-78Q4ZV Selecting a Matrix cell on the right-hand side of the grid 
caused the grid to jump to the left.

3.2.0 1-785LPA Stack gradient color disappeared after mouse over, then 
mouse out.

3.2.0 1-785LOQ Stack (|) layout had text displayed horizontally instead of 
vertically.

3.2.0 1-77QQDH Splitter handle custom image could fail in distributed 
deployments. 

3.2.0 1-75ZTPK Menus bound to lists didn’t always work properly, because 
the Object ID argument was missing from jsx3.gui.Menu 
setMenu().

3.2.0 1-74NKU7 
and 
1-75ZTO1

In CDF data, images in tree/menu/list/grid that refer to 
JSX/images or JSXAPPS/application_dir/images didn’t 
resolve correctly when the JSX directory and 
JSXAPPS/application_dir directory didn’t reside in the same 
directory as the launching HTML page.

3.2.0 1-748XL9 Dialog failed to paint content after being maximized if it 
was window-shaded.

Closed in 
Release

JIRA # Defect # Summary (Sheet 19 of 21)
 TIBCO General Interface Release Notes



106 |   Release Notes
3.2.0 1-70ZZYW Missing a method to unselect a selected item in Grid. There 
wasn’t a functional equivalent to List behavior.

3.2.0 1-6XUR3U Pressing Tab or Shift+Tab while in an open select or combo 
box should select the current item, close the select/combo, 
and move focus to the next (previous) item. 

3.2.0 1-6VWJ99 jsx3.gui.Grid — Grid won’t accept a drop unless the 
auto-expand property was set to TRUE. This resulted in an 
on-screen control that added extra rows to the view each 
time the user clicked in the last row of the Grid.

3.2.0 1-6RBJ3S Keyboard navigation couldn’t be used with the Date Picker 
component, which obstructed the process of using the Tab 
key to select components. 

3.2.0 1-6OUN7V jsx3.gui.List/Grid - Unselectable nodes in List/Grid 
could trap focus, blocking keyboard navigation past those 
items.

3.2.0 1-6OJO49 jsx3.gui.Tree - Trees with hidden root nodes took a 
long time to paint when they were enclosed several levels 
deep within other components, and the ancestor 
components were repainted. Setting the Show Root Node 
property to Hide caused 15 second repaint. Setting to Show, 
resulted in instant repaint.

3.2.0 1-6A9E3T jsx3.gui.Tree — Key navigation in a tree followed the 
order of the records in the underlying CDF document. If 
the View was resorted using the XSL parameter 
jsxsortpath, arrow key navigation in the tree wouldn’t 
follow the order of onscreen tree nodes, resulting in 
unexpected behavior.

3.2.0 1-3HVT9B The Properties Editor palette was missing a no border 
property.

3.1.1 1-70Q8IS Combo control for grid failed to check for 'null' on the 
'select' event, causing quirky behavior.

Closed in 
Release
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Installation and Build

L10N

3.1.1 1-6XJTCH Dialogs — Clicking a Dialog icon in the taskbar should 
bring the dialog forward if it wasn’t forward. Instead, it 
minimized the dialog. The requested behavior follows that 
of Windows taskbar and Windows icons.

3.1.1 1-6X98XH Alerts with large text blocks didn’t scroll and the OK 
button disappeared.

3.1.1 1-6WT94Q The Radio button prototype column didn’t have a default 
groupname, so the radio button column didn’t work as 
expected.

Closed in 
Release

JIRA # Defect # Summary (Sheet 21 of 21)

Closed in 
Release

JIRA # Defect # Summary

3.9 GI-698 Add full support for the Finnish locale (FI).

3.9 GI-588 Build tool  fails on Ubuntu/Solaris systems due to 
limitation in Java method File.renameTo.

3.8.0 GI-571 General Interface localized strings are broken for several 
locales.

3.7.1 GI-505 Build process generates severe warnings on Windows.

3.7.1 GI-498 Build process should be able to use the obfuscation name 
mapping from the previous run.

3.1.1 1-6ZL8JH When overwriting an existing installation, the Installer 
permanently deleted user-created files (files which were 
not installed as part of the package). 

Closed in 
Release

JIRA # Defect # Summary (Sheet 1 of 2)

3.9.2 GI-960 Portuguese translation for - Select - should be - Selecione -.
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Samples

3.9.1 GI-850 Localized boot text does not display if the navigator 
language property is set with language-Country (i.e. 
fr-FR).

3.9.1 GI-843 Translation for "Powered By" is incorrect for Japanese and 
possibly other languages.

3.9.1 GI-847 Clean up and update localization texts.

Closed in 
Release

JIRA # Defect # Summary

3.4.0 1-8494E7 Because Xignite now requires registration for access to the 
service, the WSDL_Mapping_2 sample has been modified 
to run in Static mode. To receive live data, you must 
register with Xignite and modify the sample to run in Live 
mode.

Closed in 
Release

JIRA # Defect # Summary (Sheet 2 of 2)
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Known Issues

This section discusses known issues in the named releases.

Browser Limitations and the Margin Property
The behavior of the margin property varies by browser as follows:

• Internet Explorer applies all margins properly when the object is rendered, 
but if an ancestor container is ever hidden (display:none), the left margin is no 
longer honored when redisplayed. 

• Firefox applies all margins if the object does not specify an overflow property 
(overflow:hidden, overflow:auto, overflow:scroll). If the object uses overflow, 
the top and bottom margin settings aren’t honored.

In summary, margin properties are honored as follows:

• The only margin setting that is honored by all browsers in all situations is 
margin-right.

• The margin properties, margin-top, margin-bottom, and margin-right, are 
honored in all browsers if the object does not specify an overflow property of 
hidden, scroll, or auto.

• The margin properties, margin-top, margin-bottom, margin-left and 
margin-right, are honored in all browsers if the object does not specify an 
overflow property (hidden, scroll, or auto) and no ancestor of the object ever 
has its display property toggled between none and block.

Browsers - General

JIRA # Defect # Summary/Workaround

GI-988 Summary In IE and Firefox, timePicker.setValue('12:00:30.999 
AM') returns the value 12:NaN:NaN.NaN.

Workaround Do not specify milliseconds in Timepicker.setValue().

Identified in Version 3.9.1
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Data Mapping Tools 

Documentation

JIRA # Defect # Summary/Workaround

1-8S15KL Summary When closing the Mapping Utility while focus is active on the 
autorow’s Path/Value cell, an exception is thrown in Internet Explorer. In 
Firefox, this same scenario causes the "Unsaved File" dialog with no 
exceptions. 

Workaround None

Identified in Version 3.5.1

1-7YL8IO Summary In Internet Explorer 7 with MSXML 3.0, when you select a 
complex parent type in the Rules tree of the XML Mapping Utility and 
choose Map > DOM (Map and Create), the menu command fails.

Workaround Select a child or children of the complex parent type and 
choose Map > DOM (Map and Create).

Identified in Version 3.3.0

1-70DGBK Summary While retrieving and parsing a remote WSDL document in the 
XML Mapping Utility, if the developer makes a typo in the URL, General 
Interface Builder locks up until the server returns a “document not found” 
error.

Workaround Do not make typos in the URL field or work from a local copy 
of the WSDL.

Identified in Version 3.1.0

JIRA # Defect # Summary/Workaround

1-7T8VF1 Summary Not all classes that extend Block implement all of the methods 
or input types available to Block. In these cases, the API documentation 
lists those methods. The Properties Editor palette accepts and displays 
only the correct members.

Workaround none

Identified in Version 3.2.0
TIBCO General Interface Release Notes



Known Issues | 111
Dojo Integration

Firefox

JIRA # Defect # Summary/Workaround

GI-1003 Summary GI Dojo integration using Dojo-1.4.1 does not work on IE10/11.

Workaround None

Identified in Version 3.9.1

GI-928 Summary DOJO Rating widget is broken.

Workaround  None

Identified in Version 3.9.1

GI-605 Summary Dojo widgets do not support XHTML.

Workaround  None

Identified in Version 3.8.0

JIRA # Defect # Summary/Workaround (Sheet 1 of 4)

1-9AXKKQ Summary Builder hot keys such as CTRL+S are not captured on 
Windows Firefox3. 

Workaround None

Identified in Version 3.7.0

1-8UQPI1 Summary Firefox 3 default security configuration prevents loading of 
script files from file:// URL from multiple directories (or sub 
directories).

Workaround Disable the strict same origin.

1. Have the browser URL open about:config.

2. Type security in the textbox to filter down to security 
configuration properties only.

3. Look for the setting for 
security.fileuri.strict_origin_policy and change the value 
to false by double clicking on the value.

Identified in Version 3.6.1
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1-96GSDO Summary When GI is opened in Firefox 3, the error console that is 
displayed when you click Control+Shift+J shows multiple errors 
warnings and messages.

Workaround None

Identified in Version 3.6.1

1-8WAPHK Summary In Firefox 3, for a migrated 3.4 project that had a delete column 
proptotype with no width+height on the delete button mask, the delete 
image in a matrix delete column is not displaying. 

Workaround  Either re-create the column in version 3.6 (using the 
prototype with height/width information for the image button mask), or 
manually set the height+width value. 

Identified in Version 3.6.1

1-8W2GIP

1-953POT

Summary General Interface Builder fails to load on a fresh install of 
Firefox 2.0.0.12 and 3.x because of security settings being locked in to it.

Workaround  Create a new developer-only Firefox profile so you can 
create a project workspace directory when running General Interface 
Builder. Do not use your default profile for this. Manually grant the 
permissions in Pref.js found under <user_home>/Application 
Data/Mozilla/Firefox/Profiles as shown below. You need not 
manually edit Pref.js because Firefox will prompt you to grant the 
UniversalXPConnect privilege when General Interface Builder starts. 

Add these settings if they do not exist; if these settings exist, edit them as 
follows:

user_pref("capability.principal.codebase.p0.granted", "UniversalXPConnect UniversalBrowserRead");
user_pref("capability.principal.codebase.p0.id", "file://");
user_pref("capability.principal.codebase.p0.subjectName", "");

Identified in Version 3.5.1 and 3.6.1

1-927BZ7 Summary A bug in Firefox 2 prevents General Interface from displaying 
localized boot messages. 

See https://bugzilla.mozilla.org/show_bug.cgi?id=285267.

Workaround  To change the default browser locale for Firefox, change the 
property general.useragent.locale in about:config to your 
preferred locale.

Identified in Version 3.6.0

JIRA # Defect # Summary/Workaround (Sheet 2 of 4)
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1-91CQX5 Summary When Firebug is enabled for local file and network 
monitoring, XMLHTTP requests result in permission denied exceptions. 

Workaround Disable network monitoring when Firebug is enabled for 
local file and network monitoring.

Identified in Version 3.6.0

1-8HVR2F Summary Firefox doesn't allow cross-domain XMLHttpRequests for 
security reasons.

Workaround  For test environment and those willing to risk the security 
vulnerability, here is how to bypass the cross-domain restriction:

1. Create a new Firefox profile called Test-only

2. Close Firefox

3. Edit the file prefs.js in your Firefox Test-only profile folder

4. Add this line anywhere in the file:

user_pref("capability.policy.default.XMLHttpRequest.open
", "allAccess");

5. Save the file and re-open Firefox. 

Identified in Version 3.5.0

1-83YTXT Summary On Firefox, if a textbox is a child of a relatively positioned 
Block with absolute size (W:200,H:200), the textbox takes on the height of 
the Block container even though it specifies a different height 
(W:100,H:30). This is due to a Firefox bug.

Workaround Nest an additional 100%x100% relatively positioned block 
and THEN put the textbox inside of that one. This has the effect of 
insulating the textbox from the outermost box and the corruption it is 
causing.

Identified in Version 3.4.0

1-78I4SR Summary On a Mac, text in charts on Firefox 1.5.x doesn’t display 
properly. The text is drawn correctly but after dragging the parent, it isn't 
redrawn. In some cases, text is drawn when the scroll bar is scrolled. This 
defect has been reported to 
https://bugzilla.mozilla.org/show_bug.cgi?id=316564.

Workaround none

Identified in Version 3.2.0

JIRA # Defect # Summary/Workaround (Sheet 3 of 4)
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Mac and Firefox Known Issues

Mac OS X and Firefox have these known issues:

• The JavaScript Step Through Debugger isn’t supported in Firefox. To debug in 
Firefox, use the Firebug browser add-on.

• Inconsistent scroll bar support on Mac OS X. Also if layering is used, such as a 
dialog layered over an application, scroll bars bleed through. This occurs 
whenever z-index is used. See defect 1-7SGRHB in Known Issues on page 109.

• For charting on Firefox with Mac OS X, some SVG behavior is unexpected. For 
example, text isn’t always rendered properly due to clipping. This is possibly 
related to scrolling. See defect 1-78I4SR in Known Issues on page 109.

• Mac OS X accelerator keys don't always work in Firefox.

• Firefox doesn’t support jsx3.net.Form with file upload. As an alternative, 
set the Text/HTML property of a Block component to free form HTML 
containing a form element.

• Unexpected layout behavior in Firefox with the Block component, such as 
misaligned GUI components, when using relative positioning. 

1-7T87PZ Summary On Firefox, when you drop a charting component onto the 
work area and try to shift focus to that component using the Show/Hide 
Focus Rectangle button, the charting component doesn’t receive the 
focus. Therefore, you can’t drag and drop the component as desired. This 
defect has been reported to 
https://bugzilla.mozilla.org/show_bug.cgi?id=360141.

Workaround none

Identified in Version 3.2.0

1-74L8YJ Summary General Interface Builder error sound does not play properly 
in Firefox 1.5.x. 

Workaround Download and install a plug-in for .wav files. 

Identified in Version 3.2.0

1-7A9DSG Summary Firefox can’t open non-XML files encoded as UTF-16. 

Workaround Use the General Interface Builder IDE, Internet Explorer, or 
a text editor to convert to 8-bit encoding before opening in Firefox.

Identified in Version 3.2.0

JIRA # Defect # Summary/Workaround (Sheet 4 of 4)
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Workaround To avoid unexpected layout behavior in deployed applications, 
it’s recommended to use Block as a container only if it meets one of these 
requirements:

— The Block is owned by a layout manager, such as LayoutGrid, Tab, Stack, 
and Splitter.

— The Block is relatively positioned and has a width of 100%.

— The Block is absolutely positioned.

• Overflow on a draggable object, such as a dialog, is hidden. 

Workaround Make the dialog visible by adding width and height.

• XPath/XSLT in Firefox

— The XSL must meet these requirements in Firefox or it fails:

The XSL must point to this namespace: 
xmlns:xsl="http://www.w3.org/1999/XSL/Transform" 

The XSL must output valid XML. Balanced tags are required. For example, 
<xMessage>Hello World!</xMessage>

— XSLT implementation does not support the namespace axis, limiting the 
ability to query and discover namespaces. The DOM-based interface also 
fails to implement this axis.

— XSLT implementation does not support the node-set() method, which 
means that complex parameters and result tree fragments cannot be 
resolved.

— XSLT implementation does not allow output escaping to be disabled, 
which means that escaped entities cannot be resolved during a 
transformation. 

The only output formats supported for XSLT processing are HTML 4.0 and 
XML.
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General Interface Builder

JIRA # Defect # Summary/Workaround (Sheet 1 of 3)

GI-998 Summary When pressing the Enter key and Tab key in IE 10, the input 
caret skips to the line above instead of the next line in the source 
editor (css, js, xml).

Workaround None

Identified in Version 3.9.2

GI-944 Summary Malformed XML makes the Alert dialog undraggable. 
Throws uncaught exception when user clicks in the dialog.

Workaround  Don't drag the error alert box, just dismiss it (click OK).

Identified in Version 3.9.1

1-9K7L6D Summary The type-ahead feature is no longer provided in the script , 
XML and XSL editors.

Workaround  None

Identified in Version 3.7.0

1-9GHSMW Summary When GI is first launched in HTA mode builder does not 
register the initial workspace directory setting.

Workspace directory is registered only after second try.

Note : this is not a problem If GI is first launched HTML mode then 
HTA is used after workspace is already configured.

Workaround  None

Identified in Version 3.7.0

1-992QYN Summary Currency symbol is currently not localized.

Workaround  Manually edit locale xml and add the symbol value 
for number.currency.

Identified in Version 3.6.1 and 3.7.0
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1-9239YG Summary When using the Properties Editor resource, you cannot 
browse to your workspace directory if the current assign path is a 
system path such as, jsx:///images/list/select.gif. 

Workaround  Remove the path value before using browse or set the 
path value to jsxapp:// , which will direct the browser to start from 
the workspace directory.

Identified in Version 3.5.1

1-8EB787 Summary General Interface Builder doesn’t repaint correctly when a 
palette is resized after adding a Mask-Dialog column in Matrix. 

Workaround  None

Identified in Version 3.5.0

1-852K7J Summary Internet Explorer external add-ons, such as Yahoo and 
Developer toolbars, might interfere with opening the API 
documentation in a separate window (Help > API Documentation > 
Open in separate window) and trigger multiple blank pages in 
Internet Explorer 6 and Internet Explorer 7. 

Workaround Open the API documentation in a dialog or in the HTML 
version or disable external add-ons before opening in a separate 
window.

Identified in Version 3.4.0

1-84SURZ Summary In Internet Explorer 7, you can’t open General Interface 
Builder in XHTML mode (GI_Builder.xhtml) even though the 
xhtml extension is configured to be opened by Internet Explorer 7. If 
you attempt to open General Interface Builder in XHTML mode, the 
Open/Save/Cancel dialog displays.

Workaround Rename the file to GI_Builder.xhtml.html to open 
with Internet Explorer 7.

Identified in Version 3.4.0

JIRA # Defect # Summary/Workaround (Sheet 2 of 3)
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1-7T33C9 Summary On Mac, menu accelerator hot keys aren’t working for some 
General Interface Builder menu items. For example, IDE Settings 
(Ctrl+,), Project Settings (Ctrl+Shift+,), and all palettes(Ctrl+1, Ctrl+2, 
and so on). This defect has been reported to 
https://bugzilla.mozilla.org/show_bug.cgi?id=106048.

This applies to only to Firefox 1.5.x and 2.0.x.

Workaround  None

Identified in Version 3.2.0

1-7QJTEX Summary In Internet Explorer, you can’t create a new folder under the 
C:\ root directory using the Create New Folder button while creating 
a workspace folder. Creating subfolders under an existing folder is not 
an issue.

Workaround Create the folder under the C:\ root directory in the 
Windows file manager. In General Interface Builder, choose the 
Browse button in the Create or Locate a Workspace dialog or in the 
Workspace field of the IDE Settings dialog (Tools > IDE Settings > 
Paths) and select the newly created folder.

Identified in Version 3.2.0

1-79MFUX Summary Firefox determines the user home from the install directory 
and is case-sensitive, even though the file system is case-insensitive. 

Workaround If you change the browser URL from C: to c:, you need to 
specify the user home directory again. 

Identified in Version 3.2.0

JIRA # Defect # Summary/Workaround (Sheet 3 of 3)
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General Interface Framework

GUI Components

JIRA # Defect # Summary/Workaround

GI-932 Summary Using a child GUI object  that calls setName() can cause a 
memory leak when you unload only this child object and not the top 
parent object of  a loaded serialization file.

Workaround  Do not call setName() on a child GUI object if you plan to 
unload it instead of the top parent object of a serialization file.

Identified in Version 3.9.1

1-8PGCCD Summary Provide the ability to specify a default date and display a 
different background color for this default date in the DatePicker's 
Calendar .

Workaround None

Identified in Version 3.9.0

GI-104 1-85O3Z2 Summary Moving focus to an object which is outside the current browser 
display area causes the entire application to shift in the browser window. 

Workaround Move the offending object, such as a dialog, again to restore 
the view or Shift+Tab to tab back.

Identified in Version 3.2.0

JIRA # Defect # Summary/Workaround (Sheet 1 of 2)

GI-451 1-9A9XZZ Summary Table.getNoDataMessage() is not able to be used, and the 
default message is a blank space.

Workaround  None

Identified in Version 3.6.0
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Safari and Chrome

1-7SGRHB Summary On Mac OS X, if multiple dialogs are open, the vertical scroll 
bars of the bottom dialog bleed through to the dialog on top. This defect 
has been reported to 
https://bugzilla.mozilla.org/show_bug.cgi?id=187435.

Applies to Firefox 1.5.x and 2.0.x only.

Workaround  None

Identified in Version 3.6.0

1-8UCEE0 Summary Using the setDate(new Date("11/11/11)) method on Firefox 
and Internet Explorer, sets the year to 1911, but on Safari, the date is 2011. 

Workaround  Always use 4-digit years.

Identified in Version 3.5.1

1-754023 Summary Cursor in text tabs bleeds through a dialog in front of it.

Workaround  None

Identified in Version 3.1.0

JIRA # Defect # Summary/Workaround (Sheet 2 of 2)

JIRA # Defect # Summary/Workaround (Sheet 1 of 2)

1-95LYE7 Summary The column resize icon does not display where expected in 
Safari 3. The resize icon is not visible, but a blue line indicates where the 
icon is displayed. 

Workaround  Move the mouse pointer slightly to the right to find the 
resize icon bar.

Identified in Version 3.6.1 

1-964LI3 Summary The TAB key does not work for General Interface Form 
elements such as button, image button, slider, select, menu, tree, matrix 
tree, matrix grid. The Combo form elements works because it has a input 
box.

Workaround  None

Identified in Version 3.6.1 
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1-96AM5D Summary You cannot use the down arrow key for navigation in the Select 
and Combo Select elements. This is a Safari defect on implementation of 
the tabIndex property and will be addressed in a new Safari release.

Workaround  Use mouse navigation.

Identified in Version 3.6.1 

JIRA # Defect # Summary/Workaround (Sheet 2 of 2)
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